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Chapter 0 - Introduction
This training material is part of the FME Training
Pathway system.

Training Pathway
This training material - the FME Desktop Location Intelligence Course - is a key part of every
FME Training Pathway.
It assumes a basic familiarity with the concepts and practices covered by the FME Desktop
Tutorial, and covers material that will be required to take specific Pathway Training Courses.

FME Version
This training material is designed specifically for use with FME2014 SP1. You may not have
some of the functionality described if you use an older version of FME.

Sample Data
The sample data required to carry out the examples and exercises in this document can be
obtained from: http://www.safe.com/learning/training/resource-center/sample-dataset/.
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Course Overview

This is the introductory-level, training course for Safe
Software’s FME Desktop application.

Course Goal
This training course provides a framework for a basic understanding of FME, upon which a user
can base their work. We find users come to master one function, but go home with many new
FME uses!
The training will introduce basic concepts and terminology, help students become efficient
users of FME, and direct you to resources to help apply the product to your own needs.

Course Structure
The full course is made up of five main sections. These sections are:
l

Data Translation Basics

l

Readers and Writers

l

Data Transformation

l

Practical Transformer Use

l

FME Best Practice

The instructor may choose to cover as many of these sections as they feel are required, or
possible in the time permitted. They may also cover the course content in a different order and
will skip or add new content to better customize the course to your needs.
Therefore the length and content of the course may vary, particularly when delivered online.

About the Manual
The FME Desktop training manual is yours to keep. It not only forms the basis for FME Desktop
training – in-person or online – but is also useful reference material for future work you may
undertake with FME.
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Icons
In the training manual you may see the following icons...
Additional advice to help apply the knowledge you have learned.

A warning where misuse of FME could lead to difficulties.

Extra challenges for students who are quick to finish and want to take an exercise a
little bit further.

A feature new to, or significantly changed in, the most recent version of FME.

Questions about the course content and how it is applied.

Also, people from the city of Interopolis will also appear
from time-to-time to give you advice and dispense FMErelated wisdom.
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Course Resources

A number of sample datasets and workspaces will be
used in this course.

On Your Training Computer
The data used in this training course is based on open data from the City of Vancouver, Canada.
Most exercises ask you to assume the role of a city planner at the fictional city of Interopolis
and to solve a particular problem using this data.
Whether it's a local computer or a virtual computer hosted in the cloud, you'll find resources for
the examples and exercises in the manual at the following locations:
Location
C:\FMEData2014\Data

C:\FMEData2014\Resources

C:\FMEData2014\Workspaces

C:\FMEData2014\Output

< documents>\My FME Workspaces

Resource
Datasets used by the City of Interopolis
Other resources used in the training
Workspaces used in the student exercises.
The location in which to write exercise output.
The default location to save FME workspaces

You should also find FME pre-installed, plus a digital copy of this manual.
Please alert your instructor if any item is missing from your setup.
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Course Etiquette
For online courses, please consider other students and test your virtual machine connection
before the course starts. The instructor cannot help debug connection problems during the
course!

For live courses, please respect other students’ needs by keeping noise to a minimum when
using a mobile phone or checking e-mail.
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Introductions

Safe Software’s standalone, web-based, and embedded
software products are used by a worldwide network of
clients from a wide range of organizations and
industries.

Who are you?

What formats interest you?

What do you hope to achieve during this course?

Have you used FME before?

This is your chance to introduce yourself to the rest of the class. You may want to mention the
organization you represent, what experience you have using FME, and which formats and
functionality you’re most interested in.
Please think of the environment and don’t print this manual unless
you really need to. Using a digital copy or sharing with a colleague
will help save paper. And don’t forget to recycle printed copies
when you are finished with them!
You can find an online version of this manual at:
www.safe.com/onlinelearning
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Chapter 1 - Translation Basics
FME is specifically designed for Data Transformation. Its
key characteristics illustrate why it is so suitable for this
role.

What is FME?
FME (the Feature Manipulation Engine) is a data translation and transformation tool for solving
problems of data interoperability. Interoperability is about communication; in our case
communication by the sharing and distribution of data, and the ability to use that data
transparently.
FME is sometimes classed as a Spatial ETL application. ETL stands for Extract, Transform and
Load. It is a data warehousing tool that extracts data from a source, transforms it to fit the
users’ needs and loads it into a destination or data warehouse.
While an ETL tool will process the various column types that are in a non-spatial database or
system, a Spatial ETL tool must also have the spatial operations - geoprocessing capabilities
that change the structure and representation of spatial data – needed to move data from one
spatial database or GIS to another.

About FME
At the heart of FME is an engine that supports an array of data type and data formats; from GIS
and CAD to BIM and Point Cloud, via XML, Raster, databases, and many more.
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This capability is made possible by a rich data model designed to cover all possible geometry
and attribute types. When limitations in the destination (output) format cause incompatibility,
FME automatically compensates to create a seamless translation process.
FME also provides tremendous transformation functionality, resulting in output that can be
much greater than the sum of the inputs. This functionality is exposed to the user through an
ingenious and versatile graphic interface.
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FME Desktop Components

FME comprises a number of spatial data handling
components. Everything here is included with every
edition of FME Desktop.

FME Applications
The two key applications within FME are FME Workbench and the FME Data Inspector.
FME Workbench
FME Workbench is the primary tool for defining data translations and data transformations. It
has an intuitive point-and-click graphic interface to enable translations to be graphically
described as a flow of data.
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FME Data Inspector
The FME Data Inspector is a tool for viewing data in any of the FME supported formats. It is
used primarily for previewing data before translation or reviewing it after translation.

FME Utilities
FME Quick Translator
A precursor to FME Workbench that is used only for quick translations requiring no data
transformation.
FME Integration Console
A tool for applying FME functionality to other GIS and CAD applications; commonly enabling use
of datasets not normally supported by those applications.
FME Licensing Assistant
An application for managing FME licensing.

Other FME Components
Additional components are also included as part of FME Desktop (Professional Edition or
higher).
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FME Command Line Engine
The FME Command Line Engine enables translations to be initiated at the command line level.
FME Plug-In SDK
The FME Plug-In SDK allows developers to add formats and functionality to the FME core.
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Other FME Products

The FME brand name covers other products than FME
Desktop.

FME Server
FME Server is a scalable, networked data translation and transformation application.
FME Server:
l

Allows Desktop users to share translation resources through a repository mechanism

l

Allows Desktop users to run resource intensive translations on a dedicated server

l

Allows non-FME users to run translations on demand

l

Allows translation output to be streamed directly to a chosen spatial application

See http://fmeserver.com/ for more information.
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FME Cloud
FME Cloud is a solution for running FME Server as a web service, on a pre-defined virtual
machine, using a "pay-as-you-go" business model.

See https://fmecloud.com/ for more information
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FME Extensions
Besides the basic functionality of FME Desktop, there are a number of optional extra extensions
that may be purchased. These extensions add to either the functionality or format reach of the
basic FME product.
See http://www.safe.com/solutions/specialty/ for more information.

FME Store

The FME Store is a marketplace for FME components that also add functionality or formats to
FME. Offerings include both free and licensed products, provided by either Safe Software or 3rd
party partners.
See http://fmestore.safe.com for more information.
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Introduction to FME Workbench

Workbench is FME’s primary tool for defining data
translations and transformations.

What is FME Workbench?
FME Workbench is the primary tool for defining data translations and data transformations. It
has an intuitive point-and-click graphic interface to enable translations to be graphically
described as a flow of data.
Workbench is fully integrated to interact with other FME Desktop applications such as the FME
Data Inspector and other products such as FME Server and FME Cloud.
Starting FME Workbench
Find FME Workbench in the FME Desktop sub-menu in the Windows start menu. Click on the
sub-menu entry to start Workbench.

The startup tab links to a live web page and therefore the display will change over time as new
information and resources are shown.
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A second tab – Main – displays a canvas where the actual translation will be graphically
defined.

Major Components of FME Workbench
The FME Workbench user interface has a number of major components.
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Menu bar and Toolbar
The menu bar and toolbar contain a number of tools: for example, tools for navigating around
the workspace, controlling administrative tasks, and adding or removing Reader (source)
datasets.
Canvas
The FME Workbench canvas is where users graphically define a translation. This definition is
called a “workspace” and can be saved for re-use later.
By default the workspace reads from left to right; data source on the left, transformation tools
in the center, and data destination on the right. Connections between each item represent the
flow of data and may branch in different directions, merge together, or any combination of the
two.
The canvas is the primary window within Workbench and the focus of all your work.
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Police Chief Webb Mapp says...
To be precise the application itself is called Workbench, but the
process defined in the canvas window is called a “Workspace”. The
terms are so similar that they are easily confused, but please don't,
otherwise I will have to send my grammar squad to arrest you!
Although mistreating FME terminology is a minor offence the
ignominy of being caught is long lasting!!!
Navigator
The Navigator window is a structured list of parameters that represent and control all of the
components on your workspace canvas.
Transformer Gallery
The transformer gallery is a tool for the location and selection of FME transformation tools.
Translation Log
The log window (translation log) shows a report on translation results. Information includes
any warning or error messages, translation status, length of translation, and number of
features processed.

Window Control
All windows in the Workbench interface can be detached from a fixed position and deposited in
a custom location by clicking on the frame of the window and dragging it into a new position.
The windows can even float outside of the main Workbench window.
Windows can be docked within Workbench by dragging them onto the Workbench window
frame. Windows can be docked to either the left, right, upper or lower boundaries of the
Workbench frame.
If a window is dragged and dropped on top of an existing window, then the two will become
tabbed.
If a window is dragged and dropped beside an existing window (or between two existing
windows), then they will become stacked.
This user has opted to dock the Navigator and Transformer Gallery on the left and right sides of
Workbench respectively. The Log window is docked in its traditional position at the bottom of
the window.
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FireFighter Mapp says…
“Here's a hot tip for you. Don't feel put out by a lack of canvas
space. Pressing F11 instantly dispatches the lesser-used windows to
one side and expands the canvas window to an alarming size!"

Miss Vector says…
‘Attention please! It’s time for a quiz to see what you’ve learned so far.
Turn to a fellow student and answer these questions between you.’

FME Desktop can seamlessly translate between so many formats because it has...?
1) A sentient data dictionary
2) A retro-encabulator
3) A rich data model
4) A core of unicorn hairs
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Which of the following applications are parts of FME Desktop?
1) FME Workbench
2) FME Server
3) FME Quick Translator
4) FME Data Inspector

Which of the following windows are on the Workbench interface?
1) Navigator
2) Transformer Gallery
3) Log Window
4) Display Control Window
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Getting Started

Workbench’s intuitive interface makes it easy to set up
and run a simple format-to-format (‘quick’) translation.

The Start Tab in FME Workbench includes a section called "Getting Started". This section has
links to the different ways in which a workspace can be created. The simplest method is
Generate Workspace.

Generate Workspace Dialog
The Generate Workspace dialog condenses all the choices to be made into a single dialog box.
The Generate Workspace dialog has fields for defining the format and location of both the data
to be read, and the data to be written.
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All format selection fields in FME are both a pull-down menu and a text entry field. The dropdown list shows the last ten formats used, so favourite formats are instantly available.
The text entry field allows you to type a format name directly. It has an ‘intelli-complete’
function that selects close matches as you type.
Format selection can also be made by clicking the browse button to open a searchable Formats
Gallery.
Dataset selection fields are a text entry field, but with a browse button to open an explorer-like
dialog.

Red coloring in an FME dialog indicates mandatory fields.
Users must enter data in these fields to continue. In most
dialogs the OK button is de-activated until the mandatory
fields are complete.

Feature Types Dialog
Whenever a source dataset contains multiple layers the user is prompted to select which are to
be translated.
This is achieved through the Select Feature Types dialog. In FME ‘Feature Type’ is another term
for ‘layer’. Only selected layers show in the workspace.
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Here, for example, is a Select Feature Types dialog where the user has chosen to include all
available layers within the workspace.

In the Generate Workspace dialog, why might it be useful to set the data format
before browsing for the source data?
Try browsing for a dataset before setting the format type and see if you can detect
the difference.

The New Workspace
A new workspace reads from left to right, from the layers in a source (Reader), through a
dataflow to the layers in a destination (Writer). One could also think of these as the ExtractTransform-Load stages of a spatial ETL process.
A new workspace resembles this example.
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Arrows denote the direction of data flow, from source to destination.
Terminology: In most cases FME uses the terms ‘Reader’ and ‘Writer’ instead of
‘Source’ and ‘Destination’. A later chapter explains the why. For now, just be aware
that a Reader reads datasets and a Writer writes datasets, and these terms are
analogous to source/destination and input/output.
Running the Translation
The green arrow (or ‘play’ button) on the Workbench toolbar starts a translation.

There are also options under File on the menu bar to either ‘Run’ or ‘Prompt and Run’ a
translation.
The File menu with run options include shortcut keys that can be used – the F5 key to simply
run a translation and Ctrl+R to prompt and run a translation.
Saving the Translation
Workspaces can be saved to a file so that they can be reused at a later date. The save button
on the toolbar is one way to do this:

Again there are menu options to do the same thing, in this case File > Save (shortcut =
Ctrl+S) or File > Save As.
The default file extension is .fmw. Double-clicking a *.fmw file in Explorer starts FME
Workbench and opens up the workspace.”
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Firefighter Mapp says…
‘File > Open Recent shows a list of previously used workspaces.This
list is expandable to show up to a towering 15 entries.’

The ‘Run’ option carries out a translation using the same parameters and settings
used previously. The ‘Prompt and Run’ option prompts for new values for
parameters and settings.
Regardless of this, however, the ‘Run’ option must still prompt for parameters that
have not yet been filled in and don’t have default values.

Translation Results
After running a translation related information and statistics are found in the Workbench log
window.
The translation log reveals whether the translation succeeded or failed, how many features
were read from the source and written to the destination, and how long it took to perform the
translation.
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In this example the log file reveals that 3995 features were read from a MicroStation DGN file.
These features were written to a MapInfo TAB dataset..
The overall process was a success (with some warnings).
The elapsed time for the translation was 1.1 seconds.
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Basic Workspace Creation
Exercise 1a Basic Workspace Creation
Scenario

FME Workspace Author

Data

Cell Signal Strength (CSV)

Overall Goal

Create a workspace to translate Cell signal strength in Comma
Separated Value format to MapInfo TAB

Demonstrates

Basic workspace creation with FME Workbench

Start Workspace

None

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise1aComplete.fmw

Let’s see how intuitive FME’s interface is by doing an example translation with minimal
instruction.
1) Start FME Workbench and use it to carry out this conversion:
Reader Format
Reader Dataset
Parameters
Coord. System

Comma Separated Value (CSV)
C:\FMEData2014\Data\CellSignals\DataPoints.csv
For the Schema Attributes 'longitude' and 'latitude', set the Type to x_
coordinate and y_coordinate, respectively.
LL83

Writer Format
Writer Dataset

MapInfo TAB (MITAB)
C:\FMEData2014\Output\Training
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For now, ignore the Workflow Options and leave the default of ‘Static Schema.’
Run the translation. Locate the destination data in Windows Explorer to prove that it’s been
written.
When a translation is run immediately in Workbench or Quick Translator, without
further adjustment, it’s known as a ‘Quick Translation.’
Because FME is a ‘semantic’ translator, with an enhanced data model, the output
from a quick translation is as close to the source data in structure and meaning as
possible, given the capabilities of the destination format.
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Congratulations! You have now:
l

Created and run an FME workspace
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Introduction to Data Inspection

Inspecting spatial data prior to, during, or after the
translation is a helpful way to verify that the process is
operating as expected.

What is Data Inspection?
To ensure that you're dealing with the right information you need a clear view of your data at
every stage of the transformation process. Data Inspection meets this need. It is the act of
viewing data for verification and debugging purposes, before, during, or after a translation.
What Can Be Inspected?
A number of different facets to spatial data may be inspected, including the following:
l

l

l

Geometry: Is the geometry in the correct spatial location? Are the geometry types
correct?
Symbology: Is the color, size, and style of each feature correct?
Attributes: Are all the required attributes present? Are all integrity rules being
followed?

l

Data Format: Is the data in the expected format?

l

Data Schema: Is the data subdivided into the correct layers, categories or classes?

l

Data Quantity: Does the data contain the correct number of features?

l

Process Output: Has the translation process restructured the data as expected?

Chef Bimm says…
‘I have a great recipe for loading CAD files into a Building Information
Model. Previewing the ingredients… I mean data… lets me detect problems
before they affect the translation.
Features in the wrong source layer could need the whole process to be repeated. Data
Inspection saves me that hassle.’
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Introduction to the FME Data Inspector

The FME Data Inspector is a utility for viewing and
examining spatial data.

The role of inspecting data in FME is not carried out in FME Workbench, but in a complementary
application; the FME Data Inspector.

What is the FME Data Inspector?
The FME Data Inspector is a utility that allows viewing of data in any of the FME supported
formats. It is used primarily to preview data before translation or to verify it after translation.
The FME Data Inspector can also be used to check data at any point during a translation; as you
use FME you’ll find this is useful for step-by-step examination of complex translations.
The FME Data Inspector is closely tied to FME Workbench so that Workbench can send data
directly to the Inspector.
What the FME Data Inspector Is Not!
The FME Data Inspector isn’t designed to be a form of GIS or mapping application. It has no allaround analysis functionality, and the tools for symbology modification and printing are
rudimentary and intended for data validation rather than producing map output.
Starting the FME Data Inspector
To start the FME Data Inspector, from the Windows start menu click FME Desktop, then on the
sub-menu click FME Data Inspector.

Major Components of the FME Data Inspector
When the FME Data Inspector is started, and a dataset is opened, it looks something like this:
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Menu bar and Toolbar
The menu bar and toolbar contain a number of tools. Some are for navigating around the View
window, some control administrative tasks such as opening or saving a dataset, and others are
for special functionality such as selective filtering of data or the creation of dynamic attributes.

View Window
The View window is the spatial display area of the FME Data Inspector. Multiple views of
different datasets may be opened at any one time.

Display Control Window
The Display Control window shows a list of the open datasets and their feature types. Tools
here let users turn these on or off in the display, alter their symbology, and adjust the display
order.

Feature Information Window
When users query a feature in the View window, information about that feature is shown in the
Information window. This information includes the feature’s feature type, attributes (both user
and format attributes), coordinate system and details about its geometry.
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Table View Window
The Table View window is a spreadsheet-like view of a dataset and includes all of the features
and all of the attributes, with a separate tab for each feature type (layer).

Log Window
The Log window reports information relating to the reading and look of a dataset that can be
used to confirm whether data has been read correctly. Some functions on the toolbar also
generate messages in the Log window.
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Using the FME Data Inspector

With the FME Data Inspector it’s easy to open and view
any number of datasets and to query features within
them.

Viewing Data
The FME Data Inspector provides two methods for viewing data: opening or adding. Opening a
dataset opens a new view window for it to be displayed in. Adding a dataset displays the data in
the existing view window; this way multiple datasets can be viewed simultaneously.
Opening a Dataset
Datasets can be opened in the FME Data Inspector in a number of ways.
l

Selecting File > Open Dataset from the menu bar

l

Selecting the toolbar button Open Dataset.

l

Dragging and Dropping a file onto any window (except the View window)

l

From within Workbench

Opening data from within FME Workbench is achieved by simply right-clicking on a canvas
feature type (either source or destination) and choosing the option ‘Inspect.'
All of these methods cause a dialog to open in the FME Data Inspector in which to define the
dataset to view.
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Adding a Dataset
Opening a dataset causes a new View tab to be created and the data displayed. To open a
dataset within an existing view tab requires use of tools to add a dataset.
l

Selecting File > Add Dataset from the menu bar

l

Selecting the toolbar button Add Dataset

l

Dragging and Dropping a file onto the view window

Inspecting Data
Once data has been opened in the FME Data Inspector, there are a number of tools available for
altering the view or querying features.

Windowing tools are:
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l

Pan

l

Zoom In

l

Zoom Out

l

Zoom to a selected feature

l

Zoom to the full extent of the data

Querying tools are
l

Query individual feature(s)

l

Measure a distance within a View window
By default the Query tool is active when you start the FME Data Inspector.
Clicking the toolbar Query button at this point only turns the tool off.

The results of a feature query are shown in the FeatureInformation window.
The upper part reports on general information about the feature; which feature type (layer) it
belongs to, which coordinate system it is in, whether it is two- or three-dimensional, and how
many vertices it possesses.
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The middle part reports the attributes associated with the feature. This includes user attributes
and format attributes (for example fme_type).
The lower part reports the geometry of the feature. It includes the geometry type and a list of
the coordinates that go to make up the feature.

Background Maps
The ability to view maps (or other imagery) as a backdrop to your spatial data is new for FME
2014. It is activated by selecting Tools > FME Options from the menubar.
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The background map dialog lets the user select an existing dataset (of any FME-supported
format) to use as a backdrop, like so:

It's also possible to use a number of different web services that supply mapping on
demand. Some of these - such as ArcGIS Online - do require an existing account:

Police Chief Webb-Mapp says....
When I'm investigating - sorry, inspecting - source data I know it
must be referenced against a valid coordinate system for
background data to be displayed. If the coordinate system is not
recorded in the dataset itself, I can enter it into a field when
opening the dataset
I've also deduced that it doesn't matter what coordinate system the data is
referenced against; FME will automatically convert it to whatever system is being
used by the background map.
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Basic Data Inspection
Exercise 1b Basic Data Inspection
Scenario

FME Workspace Author

Data

Cell Signal Strength (MapInfo TAB)

Overall Goal

Inspect the output from a previous translation

Demonstrates

Basic Data Inspection with the FME Data Inspector

Start Workspace

None

Finished Workspace

None

1) Now let’s see how the FME Data Inspector interface works by inspecting the input and output
datasets from any quick translation you have already carried out.
For example, you should be able to find the output from Exercise 1a at:
Format
Dataset

MapInfo TAB (MITAB)
C:\FMEData2014\Output\Training\CSV.tab

The dataset should look something like this:
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FME makes it easy to locate either input or output data from within FME Workbench.
Simply right-click on any Reader or Writer feature type and choose the option “Open
Containing Folder.”

Congratulations! You have now:
l

Inspected the output from an FME workspace translation
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More FME Data Inspector Functionality

The FME Data Inspector has a number of controls to
assist in showing the data in an orderly manner.

Display Control
Management of feature display order is carried out in the Display Control window.
Each dataset and feature type can be dragged above any other to promote its display order in
the View window.

Feature Types can only be ordered within their container dataset.
For example, "Private" cannot be promoted above "Parks" in the display, without the
entire Roads dataset being promoted above Parks.

Display Status
Each level of the Display Control window has a checkbox to turn data on and off at that level.
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Style
Each feature type can be assigned a different color or style that applies to its geometriesTo
access this functionality click on the style icon for that feature type in the Display Control
window:

The Drawing Style dialog allows you to set the color of a feature and its degree of
transparency. The exact settings available depend upon the type of geometry being set; for
example a polygon feature will have settings for both fill and border:
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Each Feature Type in the Display Control
window is tagged with the number of features it
contains, in parentheses after the feature type
name. Thus we can see that there are 957
arterial road links in the city of Vancouver.

Miscellaneous Viewer Functionality
The FME Data Inspector has a number of miscellaneous functions that help users navigate
through data, investigate data, and even translate data to a different format!
Shift and Ctrl Key Functions
Press the Shift key on the keyboard and it will activate the zoom-in tool in the Viewer.
Press the Ctrl key and it will activate the zoom-out tool. Release the key to revert to the
previous tool.
This functionality allows users to quickly move between query and navigation modes at the
press of a key, so there’s no need to click between query and navigation tools on the menubar
or toolbar.
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Save Tools
The FME Data Inspector save tool lets you save whatever data is currently being displayed in
the view window. The data can be saved in any FME-supported format of your choice.
Simply select File > Save Data As to open the prompt for saving data.
Data Filtering
Data in the View window can be filtered by a set of user-defined criteria to show only the
features that are required at that time. This functionality is activated by Tools > Filter
Features on the menubar.
The Filter Features dialog allows a whole series of test clauses to be set up, using a number of
operators to test the values of source data attributes. For example, here the user is filtering
(keeping displayed) all features that are located in the neighborhood of Kitsilano.
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The FME Data Inspector
Exercise 1c The FME Data Inspector
Scenario

FME Workspace Author

Data

Parks (MapInfo TAB)
Fire Halls (CSV Comma Separated Value)
Neighborhoods (Google Earth KML)

Overall Goal

Examine city data to select a suitable neighborhood to live in

Demonstrates

Viewing, symbolizing, and querying data with the FME Data Inspector

Start Workspace

None

Finished Workspace

None

In this exercise, imagine that you are a GIS technician working for a city planning department.
The mayor has asked you to help him use FME to inspect some data, to pick a neighborhood for
him to buy a new house in!
1) Start FME Data Inspector
2) Set Background
When inspecting data it will help to have a background map to provide a sense of location.
FME Data Inspector is capable of displaying a backdrop from several different mapping
services.
Select Tools > FME Options from the menubar. In the Background Map section, select a
background map format of MapQuest Web Map Tile Service:
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Click the Parameters button. A map constraint (type) dialog will open. Select OpenStreetMap.

Click OK and OK again to close these dialogs.
3) Add Data
Now let's add some data. Select File > Open Dataset from the menubar. Set the reader
parameters as follows:
Format:
Dataset:

Google Earth KML
C:\FMEData2014\Data\Boundaries\VancouverNeighborhoods.kml
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Click OK to close the dialog and add the data.
4) Set Data Symbology
The data is added to the Data Inspector, but it is a solid-filled color and therefore obscures the
background data.

MapQuest: Tiles Courtesy of MapQuest

We can fix this by setting the symbology. Click the symbology icon for the Neighborhoods data
in the Display Control window:
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In the style dialog that opens, select a suitable color for the neighborhoods (say, orange). Then
set the Transparency/Opacity scale to be somewhat less than half (i.e. more transparent than
opaque).

Click OK to accept the parameters and close the dialog. The background map will now be visible
through the neighborhood data.
5) Add More Data
The mayor has a pet dog and therefore wishes to live in an area that has a dog park. We must
therefore add some parks data to the view.
Select File > Add Dataset from the menubar. Set the reader parameters as follows:
Format:
Dataset:

MapInfo TAB (MITAB)
C:\FMEData2014\Data\Parks\Parks.tab

Click OK to close the dialog and add the data.
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6) Filter Data
The parks data is opaque too (you may optionally change this to be more transparent) but more
importantly we cannot tell which parks are dog parks.
Click on the tab marked Parks in the Table View window.

Notice that there are many parks in the city, but that there is also a DogPark attribute to tell us
which parks have a dog run area. Click on the DogPark name to sort the table data by that
attribute.
Now, clicking on a feature will highlight it on the display window, but it would be easier to find
dog parks if we could filter the data. Therefore choose Tools > Filter Features from the
menubar.
In the Filter Features dialog, double click in the Left Value field, click the drop down arrow, and
select Attribute Value. Choose DogPark as the attribute to filter by and click OK.
For the Operator field select the = (equals) symbol, if it is not already selected.
For the Right Value field, click in the field and type the character Y (it should be upper case, not
lower).
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Filtering in the Data Inspector is applied to all visible data, therefore we must also add a clause
to enable the neighborhood data to remain on screen.
Create a second test clause using the same techniques as before. This time test for where
NeighborhoodID > (is greater than) 0 (zero)

The Pass Criteria parameter should be set (or left as) "One Test (OR)."

Now click OK to close the dialog. The display will be filtered to show only the neighborhood
features plus parks with a dog run facility.

Chapter 1 - Translation Basics

56

FME Desktop Location Intelligence Manual

MapQuest: Tiles Courtesy of MapQuest

7) Add Data
The mayor's dog really is his best friend, and the mayor refuses to live in an area where there
are no rescue services, just in case he gets lost chasing a cat! So let's add some emergency
facilities data.
Select File > Add Dataset from the menubar. Set the reader parameters as follows:
Format
Dataset

Comma Separated Value (CSV)
C:\FMEData2014\Resources\LI\FireHalls.csv
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Click on 'Parameters' and set the 'Dataset Parameters - Feature Type Names(s):' to 'Feature
Type from File Name(s).'
Also, under 'Schema Attributes,' be sure to set the 'longitude' and 'latitude' to 'x_coordinate'
and 'y_coordinate' respectively.
Click OK and then set the 'Coord. System' to LL83.
Click OK to close the dialog and add the data.
8) Filter Data
Initially no data will appear on screen because we already have a filter set that will exclude it.
So, again select Tools > Filter Features from the menubar.
This time set up a test to filter where Rescue = Y (i.e. Fire Halls which are also a rescue
facility).
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At this point you should be able to suggest to the mayor a neighborhood that has both a dog
park and an emergency rescue facility. Click on the neighborhood feature to find out which it is.

Congratulations! You have now:
l

Set a background map for the FME Data Inspector

l

Opened a dataset for inspection and added more data to the same view

l

Set symbology including color and transparency

l

Queried and sorted data in the Table View window

l

Filtered data using a filtering tool
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Translation Previews

A key ability of FME is communication of data between
Workbench and the FME Data Inspector.

Redirect to Inspection Application
In some cases it’s desirable to inspect output data, but undesirable to actually have to write the
data to do so. In other words, you want to preview what the output of a translation will be.
For example, it would be useful to preview the results of a workspace that updates a spatial
database. That way mistakes can be detected before writing to the database.
The Workbench tool to do this is the ‘Redirect to Inspection Application' setting.
When this setting is applied, the output from a translation is redirected away from the specified
output and sent directly to FME Data Inspector instead.
The simplest way to turn on this ability is to select Writers > Redirect to Inspection
Application on the Workbench menu bar.

This setting is a toggle, which means that each subsequent selection alternately turns the
setting on and off.
Here a user is about to activate the Redirect to Inspection Application setting. Absence of a
checkmark shows it is not already set.
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An embarrassing problem occurs when a user forgets to deactivate the setting and
does not understand why no output datasets are being written. To help combat this
issue, the FME Log window includes a distinctive warning message when data is being
redirected.

Notice how the redirection message in the FME Log window reports that zero features have
been written to the output datasets.

Don’t get confused by the Inspection option on the menubar. It is entirely unrelated
to this form of Inspection and the Viewer.
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Module Review

This module was designed to introduce you to FME and to
investigate the basics of FME data translations.

What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
l

l

l

l

l

l

FME is a tool to translate and transform spatial data.
Quick Translation is the technique of carrying out a translation with minimum user
intervention. The semantic nature of FME is the means by which this is permitted.
FME Workbench is an application to graphically define a translation and the flow of data
within it. This definition is known as a workspace and can be saved to a file for later
use.
The Generate Workspace dialog is the main method by which a Quick Translation can
be set up in FME Workbench.
Data Inspection is a technique for checking and verifying data before, during, and after
a translation.
The FME Data Inspector is a tool for inspecting data. Multiple datasets – including data
from different formats – can be opened within the same view window.

FME Skills
l

l

l

l

The ability to start FME Workbench, set up a Quick Translation, and run it.
The ability to start the FME Data Inspector, open a dataset in a new view, and add a
dataset to an existing view; to navigate a dataset and to query features within it.
The ability to control minor FME Data Inspector functionality for debugging data and
translations.
The ability to inspect data by redirecting it from FME Workbench to the FME Data
Inspector.
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Q&A Answers
Miss Vector says…
Here are the test answers. Anything less that 3 out of 3 and you’ll find yourself
reviewing the section again during lunch!’
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FME Desktop can seamlessly translate between so many formats because it has...?
1) A sentient data dictionary
2) A retro-encabulator
3) A rich data model

P

4) A core of unicorn hairs

Which of the following applications are parts of FME Desktop?
1) FME Workbench

P

2) FME Server
3) FME Universal Translator

P

4) FME Data Inspector

P

Which of the following are windows in the Workbench interface?
1) Navigator

P

2) Transformer Gallery

P

3) Log Window

P

4) Display Control Window
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Why might it be useful to set the data format before browsing for the source data?
Try browsing for a dataset before setting the format type and see if you can detect the difference.

Answer When you set the format and then browse for a dataset FME will show only datasets of the chosen format,
making the selection task easier.
When you browse for a dataset before setting the format, FME will show all files.

Chapter 1 - Translation Basics

65

FME Desktop Location Intelligence Manual

Chapter 2 - Data Transformation
Data Transformation is the ability to manipulate data
during Format Translation – even to the extent of having
an output greater than the sum of the inputs!

What is Data Transformation?
Data Transformation is FME’s ability to manipulate data. The transformation step occurs during
the process of format translation. Data is read, transformed, and then written to the new
format.
Sometimes FME automatically manipulates the data, as part of its semantic capabilities,
renaming attributes, adjusting geometry, and splitting up data into several layers in order to
ensure that the output from a Format Translation meets the specification of the destination
format.

Data Transformation Types
Data transformation can be subdivided into two distinct types: Structural Transformation and
Content Transformation.

Structural Transformation
This type of transformation is perhaps better called ‘reorganization’. It refers to the ability of
FME to channel data from source to destination in an almost infinite number of arrangements.
This includes the ability to merge data, divide data, re-order data, and define custom data
structures.
Transforming the structure of a dataset is carried out by manipulating its schema.

Content Transformation
This type of transformation is perhaps better called ‘revision’. It refers to the ability to alter the
substance of a dataset. Manipulating a feature’s geometry or attribute values is the best
example of how FME can transform content.
Content transformation can take place independently or alongside structural transformation.
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Mr. Flibble says…
“Before you start on transformation, here’s a challenge for you!
According to user feedback, the most common format translation
defined with FME is from Esri Shape to which format?
l

Geodatabase

l

AutoCAD DXF/DWG

l

Esri Shape

l

Google Earth KML

If you’re in a class, have a group vote!”
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Structural Transformation

Transforming a dataset’s structure requires knowledge
of schemas and how to use FME to manipulate them.

Schema Concepts
A schema is the structure of a dataset or, more accurately, a formal definition of a dataset’s
structure. The term Data Model may be more familiar, but at Safe Software we stick to the
term ‘schema’.
Each dataset has its own unique structure (schema) that includes feature types (layers),
permitted geometries, user-defined attributes, and other rules that define or restrict its
content.
How Does FME Represent Schemas?
When a new workspace is created, FME scans all of the source datasets. From this it creates a
visual representation of the data’s schema on the left side of the canvas. On the right side, it
creates a visual representation of how this schema will be duplicated in the chosen output
format.
Here are source and destination schemas as they are represented in Workbench.

Each object on the canvas is a separate Feature Type within a dataset.
The workspace reads from left to right.

Chapter 2 - Data Transformation

68

FME Desktop Location Intelligence Manual

At this point, the Reader schema represents ‘what we have’; that is, FME’s view of the source
datasets. The Writer schema represents ‘what we want’; the data required by the user.
By default, the Writer schema is a mirror image of the source; differences only occur when
demanded by limitations of the selected destination format. This allows Quick Translation to
occur with no further editing of the translation by the user.
Viewing the Schema in FME Workbench
A schema goes beyond what can be seen on the workspace canvas; there are other
components in various dialogs that also represent the structure of a dataset.
Some parts of the schema relate specifically to a single feature type only. Attributes are one
such component. These components are shown in the Properties dialog of a feature type.
The Properties dialog is opened by clicking the Properties Browse button at the right side of the
feature type.

The Feature Type Properties dialog has a number of tabs that show information.
Under the General tab there is the name of the feature type, in this case AddressPoints.
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Allowed geometry types and the name of the parent dataset for the feature types are shown as
well.
The User Attributes tab shows a list of attributes. Each attribute is defined by its name, data
type, width, and number of decimal places.
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This example shows a Reader feature type. You may find these greyed out by default, since
source attributes cannot be edited because they represent the physical schema of the data. If
they were changed, the schema would no longer match the Reader dataset.
The Data Type column for an attribute shows only values that match the permitted
types for that data format. For example, an Oracle schema permits attribute types
of varchar or clob. MapInfo does not support these data types so they would never
appear in a MapInfo schema.

Schema Editing
As noted, initially the Writer schema in a workspace is a mirror image of the source. However,
in many cases the user requires the output to have a different data structure.
Schema Editing is the process of altering the destination schema to customize the structure of
the output data. One good example is renaming an attribute field in the output. After editing,
the source schema still represents ‘what we have’, but the destination schema now truly does
represent ‘what we want’.

Editable Components
There are a number of edits that can be performed, including, but not limited to the following.
Attribute Renaming
Attributes on the destination schema can be renamed, such as renaming CivicNo to
BuildingNumber.
To rename an attribute open the Feature Type Properties dialog and click the User Attributes
tab. Click the attribute to be renamed and enter the new name.
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Attribute Type Changes
Any attribute on the writer schema can have a change of type; for example, changing CivicNo
from a character field to a number field.
To change an attribute type open the Feature Type Properties dialog and click the User
Attributes tab. Use the Data Type field to change the type of an attribute.
Feature Type Renaming
To rename a destination feature type (for example, rename AddressPoints to Addresses) open
the Feature Type Properties dialog. Click the General tab. Click in the Feature Type Name field
and edit the name as required.
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Geometry Type Changes
To change the permitted geometry for a feature type, (for example, change the permitted
geometries from lines to points) open the Feature Type Properties dialog. Click the General
tab. Choose from the list of permitted geometries.
This field is only available where the format requires a decision on geometry type.

Schema Mapping
Schema Mapping forms the basis for data restructuring.
In FME Workbench, one side of the workspace shows the source schema (what we have) and
the other side shows the destination schema (what we want). Initially the two schemas are
automatically joined when the workspace is created, but when edits occur then these
connections are usually lost.
Schema mapping is the process of connecting the source schema to the destination schema in a
way that ensures the correct Reader features are sent to the correct Writer feature types and
the correct Reader attributes are sent to the correct Writer attributes.
Feature Mapping
Feature mapping is the process of connecting source feature types to destination feature types.
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Attribute Mapping
Attribute Mapping is the process of connecting source attributes to destination attributes.

Ms. Analyst says…
‘You can think of Schema Editing and Mapping as reorganizing data.
A good analogy is a wardrobe full of clothes. When the wardrobe is
reorganized you throw out what you no longer need, reserve space for new stuff that
you’re planning to get, and move existing items into a more usable arrangement.
The same holds true for spatial data restructuring: it’s the act of reorganizing data to
make it more usable”
In Workbench’s intuitive interface, the most common way to make feature type and attribute
connections is by dragging connecting lines between these parts of the schema.

Feature Mapping in FME Workbench
Feature Mapping is carried out by clicking the output port of a source feature type, dragging the
arrowhead across to the input port of a destination feature type, and releasing the mouse
button.
Here, a connecting line from source to destination feature type is created by dragging the
arrowhead from the source to the destination.

Here a user wishes to create a single layer called Transportation and so is merging two input
feature types (Roads and Rail) into one output feature type (Transportation).
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Attribute Mapping in FME Workbench
Attribute Mapping is performed by clicking the output port of a source attribute, dragging the
arrowhead to the input port of a destination attribute, and releasing the mouse button.
Here feature mapping has been carried out already and attribute connections are being made.

Notice the green, yellow, and red color-coding that indicates which attributes are connected.
Green ports indicate a connected attribute. Yellow ports indicate a source attribute that’s
unconnected to a destination. Red ports indicate a destination attribute that’s unconnected to a
source.
Feature mapping connections (or links) are shown with a thick, black arrow.
Attribute mapping connections are shown with a thinner, gray arrow.
Attributes with the same name in source and destination are connected automatically, even
though a connecting line might not be visible; the port color is the key.
Names are case-sensitive, therefore ROADS is not the same as roads or Roads
It is permitted to map ‘what we have’ to ‘what we want’ in any way that is desired.
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Schema Editing
Exercise 2a Schema Editing
Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming,
etc.

Demonstrates

Structural Transformation, Schema Editing

Starting Workspace

None

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2aComplete.fmw

In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
The first step in this example is to rename existing attributes and create new ones in
preparation for the later area calculations.
1) Start Workbench
Use the Generate Workspace dialog to create a workspace using the information that follows.
Reader Format
Reader Dataset

MapInfo TAB (MITAB)
C:\FMEData2014\Data\Parks\Parks.tab

Writer Format
Writer Dataset

MapInfo TAB (MITAB)(yes – here we write back to the same format!)
C:\FMEData2014\Output\Training

2) Update Attributes
FME creates a workspace where the destination schema matches the source.
However, the end user of the data has requested the attributes get cleaned up so that
unnecessary information is removed. Also others need to be renamed and some extra ones
added to store the calculation results.
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Open the Feature Type Properties dialog for the writer feature type by clicking the Properties
button. Click the User Attributes tab to open a list of the destination attributes. It will look like
this:

In turn, carry out the following actions:
Delete Attribute
Delete Attribute
Delete Attribute
Delete Attribute
Delete Attribute
Delete Attribute
Rename Attribute
Add Attribute
Add Attribute

RefParkID
EWStreet
NSStreet
Washrooms
SpecialFeatures
DogPark
from NeighborhoodName - to Neighborhood
ParkArea - Type Float
AverageParkArea - Type Float

After these edits the attribute list should look like this:

3) Rename Feature Type
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Now click back on the General tab.
Click in the field labelled Feature Type Name and change the name from Parks to
ParksMaintenanceData
Click OK to accept these changes.
Now when the workspace is run the output will be named ParksMaintenanceData.tab
The workspace will now look like this:

Notice there are several source attributes that are not going to be used in the workspace or
sent to the output. We can tidy the workspace by removing these attributes later.
4) Save the Workspace
Save the workspace – it will be completed in further examples.
There is nothing yet to map to ParkArea or AverageParkArea because values for
them do not yet exist, and Neighborhood is still unconnected, but you can still run
the workspace just to see what the output looks like.
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Transformation Using Transformers

Besides Schema Editing and Schema Mapping,
transformation can be carried out using objects called
Transformers.

What is a Transformer?
As the name suggests, a transformer is an FME Workbench object that carries out
transformation of features. A number of different transformers exist to carry out different
operations.
Transformers usually appear in the canvas window as rectangular, light-blue objects, although
there are some transformers that vary from the norm with special shapes and colors.
Transformers are connected somewhere between the source and destination feature types, so
that data flows from the reader feature types, through a transformation process, and on to the
writer.

Transformer Parameters
Each transformer may have a number of parameters – also known as settings. Access the
settings by clicking the Properties button at the top right of each transformer.

Color-Coded Properties Buttons
The Properties button on a transformer is color-coded to reflect the status of the settings.
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A blue Properties button indicates that the default transformer settings have been checked and
amended as required, and that the transformer is ready to use.

A yellow Properties button indicates that the default settings have not yet been checked. The
transformer can be used in this state, but the results may be unpredictable.

A red Properties button indicates that there is at least one setting for which FME cannot supply
a default value. The setting must be provided with a value before the transformer can be used.

First-Officer Transformer says…
‘When you have a red-flagged transformer, your translation just
won’t fly. You need to fix the settings before you can get off the
ground.’

Transformer Ports
Far from having just a single input and/or output, a transformer can have multiple input ports,
multiple output ports, or both.
This Counter transformer has a single input and output port.
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Notice that, in FME 2014, single input ports have been removed in favor of
connecting directly to the transformer header. This design change is intended to
help save space on the canvas.

This Clipper has multiple input and output ports. Notice too that not all of them are – or need to
be – connected.

This Logger has just a single input port...

…whereas this Creator has only a single output port!
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Data Restructuring With Transformers
Exercise 2b Data Restructuring with Transformers
Scenario

FME Workspace Author

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming,
etc.

Demonstrates

Structural Transformation

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2b-Begin.fmw

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2bComplete.fmw

In this exercise, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
We’ll now continue the previous example by filtering out dog parks from the source data (as
these have a different scale of maintenance costs) and write them to the log window. We'll also
handle the renamed attribute NeighborhoodName.
1) Start FME Workbench
Start FME Workbench and open the workspace from Exercise 2a. Alternatively you can open
C:\FMEData2014\Workspaces\DesktopBasic\Example2b-Begin.fmw.
2) Add Transformer
Let's first handle the source attribute NeighborhoodName, which was renamed Neighborhood
on the writer but not yet connected. We could do this by simply drawing a connection, but it's
generally better to use a transformer called the AttributeRenamer.
Therefore click on the feature connection from Reader to Writer feature type:
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Start to type the phrase "AttributeRenamer". This is how we can place a transformer in the
workspace. As you type, FME searches for a matching transformer. When the list is short
enough for you to see the AttributeRenamer, select it from the dialog:

This will place an AttributeRenamer transformer like so:

Notice that the parameters button is colored red because there are parameters that need to be
set for this transformer.
3) Set Parameters
Click the parameters button on the AttributeRenamer transformer to open the parameters
dialog. It will look like this:
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In the Old Attribute field, click in the field, click on the drop down arrow, and from the list that
is revealed choose NeighborhoodName as the attribute to rename.
In the New Attribute field, repeat the process but instead choose Neighborhood. The dialog will
now look like this:

We can also remove unnecessary attributes by using the AttributeRenamer; we'll simply
rename the attributes to a blank value.
In the Old Attribute field, add the following attributes, while leaving the New Attribute field
blank:
l

RefParkID

l

EWStreet

l

NSStreet

l

Washrooms

l

SpecialFeatures
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Click OK to close the dialog. Now in the Workbench canvas window you will see the
Neighborhood attribute is flagged with a green arrow, to confirm that a value is being provided
to that attribute.
4) Add Transformer
Now we should remove dog parks from the data, because these have their own set of costs.
This can be done with a Tester transformer. Click on the connection from the AttributeRenamer
output port to the Parks feature type on the Writer.
Start typing the word Tester. When you spot the Tester transformer click on it to add one to the
workspace. The workspace will now look like this:
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Notice that the Passed output port is the one connected by default.
5) Set Parameters
Click the parameters button on the Tester transformer to open the parameters dialog. Doubleclick in the Left Value field and from there click the down arrow and choose Attribute Value
> DogPark.

For the operator choose the equals sign (=) and for the Right Value click into the field and type
the value N.

Click OK to accept the values and close the dialog.
6) Add Transformer
We are now filtering out dog parks from our data, using a test on an attribute value. The
question is, what should we do with this data we have filtered out. There are many things we
could do, but for now we'll simply log the information to the FME log window.
To do this, right-click on the Tester Failed port and choose the option Connect Logger:
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A Logger transformer will be added to the workspace. This will record all incoming features to
the log window:

Loggers inserted by this method are named after – and reported in the log with – the output
port they are connected to, here Tester_Failed.
7) Run Workspace
Save and run the workspace. It is not yet complete but running it will prove that everything is
working correctly up to this point.
As an advanced task, if you have time, filter the data further to remove parks that do
not have a name; i.e. their name attribute is missing or empty. Would you need to
place a second Tester transformer, or could you incorporate the test into the existing
one?
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Congratulations! You have now:
l

Carried out schema mapping with the AttributeRenamer transformer

l

Filtered data using the Tester transformer

l

Recorded data with the Logger transformer

Miss Vector says…
‘Surprise! It’s time for another quiz to check your progress.
Turn to a fellow student and answer these questions between you.’

The ability to manipulate data during translation is called:
1) Translation
2) Transmogrification
3) Transfiguration
4) Transformation

The source and destination parts of a schema show:
1) What we have/What we want
2) What we did/What we should have done
3) What we’re adding/What we’re removing
4) Where my data was/Where it is now

Deciding how the source schema connects to the destination is called:
1) Schema Mapping
2) Schema Connecting
3) Schema Joins
4) Schema Concatenating
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Which of these isn’t a connection arrow color on an FME schema?
1) Red
2) Green
3) Blue
4) Yellow
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Content Transformation

Content transformations are those that operate on the
geometry or attribute content of a dataset.

What is a Feature?
A feature in FME is an individual item within the translation.
Typically a GIS or cartographic feature consists of a geometric representation plus a set of
related attributes. FME is capable of restructuring either of these components.

A feature in FME is the fundamental (that is, smallest) unit of FME data.
Features in FME have a flexible, generic representation; in other words they have a
basic FME definition that is unrelated to the format from which they originated.

Sometimes content transformation operates on single features, sometimes on multiple
features at once.

Ms. Analyst says…
“You can think of Content Transformation as altering or editing data.
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The wardrobe analogy still works here. You might take your clothes from the wardrobe
to clean them, or alter them, or repair them, or dye them a new color, or all sorts of
other tasks, before returning them to their place.
The same holds true for spatial data transformation: it’s the act of fixing up your data to
be cleaner and in the style you really want”

Geometric Transformation
Geometric Transformation is the act of restructuring the spatial component of an FME feature.
In other words, the physical geometry of the feature undergoes some form of change to
produce a different output.
Some examples of geometric transformation include the following:
l

l

l

Generalization – a cartographic process that restructures data so it’s easily visualized at
a given map scale.
Warping – adjustment of the size and shape of a set of features to more closely match a
set of reference data.
Topology Computation – conversion of a set of linear features into a node/line structure.

Line Intersection is another example of geometric transformation.
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Here roads have been intersected with rivers to produce points that mark the location of
bridges.

Attribute Transformation
Attribute Transformation is the act of restructuring the non-spatial component of an FME
feature. In other words, the attributes relating to the physical geometry undergo some form of
change to produce a different output.
Some examples of attribute transformation are:
l

Concatenation – joining together of two or more attributes

l

Splitting – splitting one attribute into many, which is the opposite of Concatenation

l

Measurement – measuring a feature’s length or area to create a new attribute

l

ID Creation – creating a unique ID number for a particular feature

Attribute concatenation as an example of attribute transformation.
Each line of the address is concatenated to return a single line address.

+
+
+
+

Address1
Address2
City
Province
PostalCode

= Address

Suite 2017,
7445-132nd Street,
Surrey,
British Columbia,
V3W 1J8
Suite 2017, 7445-132nd Street,Surrey, British Columbia, V3W 1J8
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Transformers used in Series

Much like a set of components in an electrical circuit, a
series of Workbench Transformers can be connected
together to have a cumulative effect on a set of data.

Chaining Transformers
Even with the large number of transformers available in FME, users frequently need a
combination or chain of transformers instead of a single one.
A string of transformers that graphically represent an overall workflow is a key concept of FME.
In this example, a DuplicateRemover transformer removes duplicate polygon features. A
Dissolver transformer merges each remaining (unique) polygon with its neighbor where there
is a common boundary. Finally each merged area gains an ID number from the Counter
transformer.

Exercise 2c Content Transformation with Transformers
Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content Transformation, Schema Mapping

Starting
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2c-Begin.fmw

Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2c-Complete.fmw
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In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
The previous two examples set up the project schema, now we’ll continue by calculating the
size and average size of each park, and ensuring that information is correctly mapped to the
destination schema.
1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2b.
Alternatively you can open C:\FMEData2014\Workspaces\DesktopBasic\Exercise2c-Begin.fmw
2) Add an AreaCalculator Transformer
To measure the area of each park feature, an AreaCalculator transformer must be used.
“Calculator” is the term for when FME computes new attribute values.
Click onto the connection between Tester Passed port and the Writer feature type Parks. Start
typing the letters “areac”. You will see the Quick Add list of matching transformers appear
beneath.
Select the transformer named AreaCalculator

3) Add a StatisticsCalculator Transformer
Using the same method, place a StatisticsCalculator transformer between the
AreaCalculator:Outputport and the ParksMaintenanceData feature type.
But do not click anything else yet! The transformer will now look like this:

Chapter 2 - Data Transformation

94

FME Desktop Location Intelligence Manual

By default the Summary port has been connected, and we need the Complete port connected
instead. But notice the little pop-up icons over the top. Click the right-hand icon (the one with
the ? character). This pops up a further list of ports:

Click on the Summary port entry to disconnect that, and then on the Complete port entry to
connect that:

These pop-up menus are a new feature in FME 2014, and are a great help in
schema mapping and other feature connections.
The latter part of the workspace now looks like this:
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4) Check AreaCalculator Settings
A yellow icon indicates the AreaCalculator has parameters that need to be checked.
Open the AreaCalculator transformer Parameters dialog.

The default settings cause the calculated value to be placed into an attribute called _area.
However, the ParksWithArea schema requires an attribute called ParkArea, so change this
parameter to create the correct attribute.
Notice that the attribute on the Writer feature type is now flagged as connected.
5) Check StatisticsCalculator Settings
A red icon indicates the StatisticsCalculator has parameters that need to be defined.
Open the StatisticsCalculator transformer’s Parameters dialog.
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The attribute to analyze is the one containing the calculated area; so select ParkArea.

Examine what the default setting is for an attribute name for average (mean) park size.
Currently it doesn’t match the ParksMaintenanceData schema, which requires an attribute
named AverageParkArea.
Change the attribute from _mean to AverageParkArea
For Best Practice reasons, delete/unset any StatisticsCalculator output attributes that aren’t
required (for example _range and _stdev)
Finally, click OK to accept the changes.
6) Run the Workspace
Run the workspace.
Inspect the result of the translation using the FME Data Inspector.
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Inspect the Table View window to discover the area of each park and the average area of all
parks.
7) Save the Workspace
Save the workspace – it will be completed in further examples.
Notice that the numbers in the Table View show the results have been calculated to
12 decimal places. This is in excess of the precision that you require. As an advanced
task - if you have time - use the AttributeRounder transformer to reduce the values to
just 2 decimal places.

Feature Count Display – Serial Transformers
Look back at the previous example’s translation. Did you notice that after the translation was
complete, each connection was marked with the number of features that had passed along it?

The feature counts show that 80 features were read, 73 passed the Tester while 7 failed (for
being dog parks) and went on to the Logger.
The Log window confirms the number of features written and lists the features that failed the
Tester.
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This number helps analyze the results of a workspace and provides a reference for debugging if
the destination data differs from what was expected.
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Transformers used in Parallel

FME Workbench permits multiple data streams, each of
which passes through its own set of transformers.

Multiple Streams
A key concept in FME is the ability to create multiple processing streams within a workflow or
to bring several streams together into one.
Similar terms to ‘stream’ are ‘flows’, ‘pipes’, or ‘pipelines’.

Creating Multiple Streams
Splitting data occurs with any transformer with multiple output ports (a Tester transformer is a
good illustration of this) but can also be achieved by simply making multiple connections out of
a single output port.
The difference is that when using multiple ports the data is being split amongst the different
streams.
However, when using multiple connections from a single port, the data is being duplicated
rather than being split. In effect it creates a set of data for each connection.
Here 50 road features are being read but, because there are multiple connections from the
feature type, multiple copies of the data are being created.
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Multiple streams are useful when a user needs to process the same data, but in a number of
different ways.
Bringing Together Multiple Streams
When multiple streams are brought into the same input port no merging takes place. The data
is simply accumulated into a single stream.
Here three streams of 50 features each, converge upon a single AreaCalculator:INPUT port.

Notice how no merging has taken place; the data simply accumulates into 150 output features.
To carry out actual merging of data requires a specific transformer such as the FeatureMerger.
Exercise 2d Content Transformation with Parallel Transformers
Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content Transformation

Starting
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2dBegin.fmw

Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2d-Complete.fmw
C:\FMEData2014\Workspaces\DesktopBasic\Exercise2d-CompleteAdvanced.fmw
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In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
Now we’ll create a label for each park and write it to a new output layer. This is best done using
a parallel stream of data.
1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2c.
Alternatively you can open C:\FMEData2014\Workspaces\DesktopBasic\Exercise2dBegin.fmw
Exercise 2c measured park areas with the AreaCalculator. Now the FME user has been asked to
add this information as labels to the output dataset.
This can be achieved using the LabelPointReplacer transformer.
2) Place a LabelPointReplacer Transformer
Click onto a blank area of canvas. Type "LabelPointReplacer" to add a transformer of this type.
Connect it to the Complete port of the StatisticsCalculator by dragging a second connection
from there to the new transformer.
3) Create new writer Feature Type
Right-click the Writer feature type and choose the option Duplicate. This creates a new
feature type (layer) in the output dataset.
Open the Feature Type properties dialog. Rename the new type to ParkLabels. In the User
Attributes tab delete all of the existing user attributes.
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Make a new connection from the LabelPointReplacer to the new feature type.
4) Check Transformer Parameters
Open the parameters dialog for the LabelPointReplacer transformer.
Click the browse button to the right of the label field to open an open text editor. We want the
label to include the park name and area, with a notation for the units too.
So, firstly double click ParkName in the list of attributes to the left:

Now press the Enter/Return key to insert a new line.
Next double-click the ParkArea attribute to add that.
Finally type "sq metres" after the ParkArea attribute.
The dialog should now look like this:
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Click OK to close this dialog.
Now click in the Label Height field and type 25 (that’s 25 working units, which in this case is
metres).
The “Always Rotate Label” parameter can be left to its default value.
Many parameter fields (like Label Height) can be set either as a constant value (by
typing it in) or set to an attribute by using “Set to Attribute Value”.
If in doubt, a tooltip is often provided to point the way.

5) Run the Translation
Run the translation and inspect the output.
Notice that the output is in two layers in two files. Use the FME Data Inspector to open both
output files in the same view.
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MapQuest: Tiles Courtesy of MapQuest

6) Save the Workspace
Save the workspace – it will be completed in further examples.

Now you know how to create a new feature type (layer) in the output, how to test
data and how to use parallel streams, why not try this task:
Identify which parks are smaller than average and which parks are larger than
average, and write them out to different feature types.
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Group-By Processing

Group-By parameters are an important tool for effective
FME data transformations.

FME transformers can carry out transformations on either one feature at a time, or on a whole
set of features at once.
For example, the AreaCalculator transformer operates on one feature at a time (to measure
the area of that one polygon feature) but the StatisticsCalculator operates on multiple features
at a time (to calculate an average value for them all).
In FME we call this set of features a "group". By default the group is ALL features entering the
transformer. However, the "Group By" parameter in a transformer lets us define several
groups based upon the value of an attribute.

Mr. Statistics-Calculator, CFO, says…
“To illustrate the point consider calculating the average age of
everyone in the room. This is the default group.
Now divide everyone up on into men and women. You have made a
set of two groups and can calculate average age per gender.
This is the same as a group-by in FME”

Here a LineOnLineOverlayer transformer is being used to intersect a number of line features.
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The selected Group-By attribute is name.
The result is a series of groups for overlaying where the features in each group share the same
value for name.
The practical outcome is that intersection will only take place on line features with the same
name.
Exercise 2e Group-By Processing
Demonstrates

Content Transformation, Group-By Processing

Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content Transformation

Starting
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2e-Begin.fmw

Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2e-Complete.fmw
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In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
The parks team has decided that they do not want the average area of park for the city as a
whole. Instead they want the average size of park in each neighborhood.
1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2d.
Alternatively you can open C:\FMEData2014\Workspaces\DesktopBasic\Exercise2eBegin.fmw
2) Set Group-By in StatisticsCalculator
This is a really simple task to do. Open the parameters dialog for the StatisticsCalculator
transformer.
Click the 'browse' button next to the Group By parameter.
Select the attribute called Neighborhood and click OK until all dialogs are closed.
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3) Run the Workspace
Save and then run the workspace.
Inspect the output data in the Table View window of the FME Data Inspector.
You should see that each neighborhood now has its own value for AverageParkArea:
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Data Inspection Using FME Workbench

Besides ‘Redirect to Inspection Application’, Workbench
can route data to the FME Data Inspector from individual
transformers.

Using an Inspector Transformer
An Inspector is a Workbench transformer – with its own distinctive look and style – that causes
data entering it to be directed to FME Data Inspector.
An Inspector transformer differs from the Redirect to Inspection Application setting because
the transformer can be applied at any point in a translation (not just at the very end) and does
not prevent the data being output to the writer. It also lets a user be more selective about
which features should be inspected.
Here data is being directed to the Inspector after a CenterPointReplacer transformer, but
before a KMLStyler.

Placing an Inspector Transformer
The best, and simplest way to apply an Inspector is to right-click the output port of an object in
Workbench and select the Connect Inspector option.

Chapter 2 - Data Transformation

111

FME Desktop Location Intelligence Manual

Here the user right-clicks the Output port of an AttributeRenamer and chooses the option
Connect Inspector.
Notice that the Inspector is named automatically using the transformer and output port names.
Here it will be "AttributeRenamer_Output". This helps to identify the data from this Inspector
(as opposed to any others) in the FME Data Inspector.

Mr. E. Dict, (Attorney of FME Law) says…
“Pursuant to clause 4a-(27) in your training course agreement, you are
required to re-open the workspace from the previous example and add
Inspector transformers to selected objects to practice using this
functionality.”
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Note that the Inspector transformer only opens the FME Data Inspector when there
are features to view. If there are zero features, then the Data Inspector will not
open!
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Coordinate System Transformation

To be located in a particular space on the Earth’s surface
the majority of spatial data is related to a particular
coordinate system.

Coordinate System Basics
Each feature that is processed by FME is coordinate system aware; that is, it knows what
coordinate system it belongs to at all times. This helps prevent confusion when reading
multiple datasets that belong to different coordinate systems.
Some users call this location of data a ‘projection’, but projection is just one
component of a definition within space. A true definition includes projection, datum,
ellipsoid, units, and sometimes a quadrant, which together is called a ‘Coordinate
System.’

Coordinate System Settings
Each source reader and destination writer within FME is assigned a coordinate system. That
coordinate system is set in the navigation pane of Workbench.
Here the source coordinate system has been defined as UTM83-10 and the destination as
BCALB-83.
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When a translation is carried out where the source and the destination coordinate systems
differ in this way, FME automatically restructures the data, at the end of the translation, so that
the output is in the correct location.
Automatic Detection of Coordinate Systems
Some data formats are capable of containing information about the coordinate system in which
they are held. Shape format is one example of this. FME can be set to detect any such
information.
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Because the source Reader coordinate system is marked
<not set>, FME will try to determine the coordinate system from the source dataset.
Because the destination Writer coordinate system is marked <not set>, FME will not reproject
the data. Instead FME writes the data using the same coordinate system as the source data.
Exercise 2f Basic Reprojection
Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Calculate the size and average size of each park in the city, to use in
Grounds Maintenance estimates for grass cutting, hedge trimming, etc.

Demonstrates

Content Transformation, Reprojection

Starting
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2f-Begin.fmw

Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2f-Complete.fmw

In this example, imagine that you are a GIS technician working for a city planning department.
The team responsible for maintaining parks and other grassed areas needs to know the area
and facilities of each park in order to plan their budget for the upcoming year. You are to use
FME to provide a dataset of this information.
The parks team has decided that the output data should be in an Albers Equal Area projection
(coordinate system = BCALB-83)
1) Start Workbench
Start Workbench (if necessary) and open the workspace from Exercise 2e.
Alternatively you can open C:\FMEData2014\Workspaces\DesktopBasic\Exercise2fBegin.fmw.
2) Edit Reader Coordinate System
On the Navigator locate the Parks [MITAB] Reader, and expand its list of settings.
Locate the setting labelled ‘Coordinate System’. The original value should be ‘<not set>’.
Double-click the reader Coordinate System setting to open the Edit Parameter dialog.
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Enter the coordinate system name UTM83-10 or select it from the Coordinate System Gallery
using the Browse button.

Remember, when a Reader’s Coordinate System parameter is defined as “<not
set>” FME will automatically try to determine the correct coordinate system from
the dataset itself.
When the source dataset is in a format that stores coordinate system information (as
it does in this example) you can safely leave the parameter unset. So this step isn’t
really necessary.
However, you MUST set this parameter when you wish to reproject source data that
does not store coordinate system information; otherwise an error will occur in the
translation.
3) Edit Destination Coordinate System
Now locate the coordinate system setting for the destination (writer) dataset.
Again the value should be ‘<not set>’.
Double-click the setting. Enter the coordinate system name BCALB-83 or select it from the
coordinate system gallery using the Browse button.
4) Run the Workspace
Save and then run the workspace.
In the log file you should be able to find…
FME Configuration: Source coordinate system set to `UTM83-10'
FME Configuration: Destination coordinate system set to `BCALB-83'

5) Inspect the Output
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Open the FME Data Inspector. Choose Tools > FME Options and turn off the background
map. If the background map is activated then the data is automatically reprojected to match,
and this would not help us verify the results of the translation.
Open the newly reprojected dataset. Query a feature. The Feature Information window should
report that the data is now in BCALB-83
Reprojection can also take place using transformers – in fact this might be
considered the better method because the transformers include extra parameters
for controlling the reprojection.
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Module Review

This module was designed to introduce you to the
concept of Data Transformation and to learn how to use
FME Workbench for more than just quick translations.

What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
l

l

l

l

A Schema describes a dataset’s structure, including its feature types, attributes, and
geometries. Schema Editing is the act of editing the destination schema to better define
what is required out of the translation. The act of joining the source schema to the
destination is called Schema Mapping. Differences between the two schemas lead to
Structural Transformation.
Content Transformation is the modifying of data content during a translation. In FME
Workbench data transformation is carried out using objects called Transformers, which
can be found in the Transformer Gallery.
Groups can be created using the Group-By option in a transformer’s parameters dialog.
Splitting data into multiple streams creates multiple copies and not a division of data.
Bringing together multiple streams combines the data, rather than merges it.

FME Skills
l

l

The ability to restructure data by adjusting the schema mapping, both manually and
through transformers.
The ability to locate transformers in Workbench and place them in the processing stream
(by all methods) to transform data content.

l

The ability to define feature groups using the Group-By option.

l

The ability to reproject data using Workbench.
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Answers
Q&A

Miss Vector says…
“Here are the test answers. Don’t you dare get #1 wrong!”

FME’s ability to manipulate data is called:
1) Translation
2) Transmogrification
3) Transfiguration
4) Transformation

P

The source and destination parts of a schema show:
1) What we have/What we want

P

2) What we did/What we should have done
3) What we’re adding/What we’re removing
4) Where my data was/Where it is now

Deciding how the source schema connects to the destination is called:
1) Schema Mapping

P

2) Schema Connecting
3) Schema Joins
4) Schema Concatenating

Chapter 2 - Data Transformation

120

FME Desktop Location Intelligence Manual

Which of these isn’t a color of connection arrow on an FME schema?
1) Red
2) Green
3) Blue

P

4) Yellow

Mr. Flibble’s challenge:
The most common FME translation is from Esri Shape to…… Esri Shape.
In other words, users are using FME for the transformation instead of the translation
capabilities!

Mr. CAD says…
‘Like many people, I bought FME solely for format translations. But the
Data Transformation tools opened a flood of new possibilities! I now
use FME to transform data, even when it doesn’t need a format change!’
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Data Transformation
Exercise 2g Data Transformation
Scenario

FME Workspace Author

Data

Election Mapping (GML) Election Statistics (Excel)

Overall Goal

Map statistics of voting patterns

Demonstrates

Basic Data Transformation

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2g-Begin.fmw

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise2gComplete.fmw
C:\FMEData2014\Workspaces\DesktopBasic\Exercise2gCompleteAdvanced.fmw

In this exercise, the municipal elections officer has asked for your help in identifying voting
divisions that had a low turnout at the last election, or that had difficulty understanding the
voting process. The results should be presented in Google Earth KML format, so staff can view
them without having to use a full-blown GIS system.
1) Inspect Data
Start the FME Data Inspector and open the two datasets we will be using:
Reader Format:
Reader Dataset:

GML (Geography Markup Language)
C:\FMEData2014\Data\Elections\ElectionVoting.gml

Reader Format:
Reader Dataset:

Microsoft Excel
C:\FMEData2014\Data\Elections\ElectionResults.xls

Notice that both datasets have a Division attribute by which to identify each voting division
(area). The Excel data is non-spatial but has a set of other voting attributes:
l

Voters: Number of registered voters

l

Votes: Number of voters who voted

l

Blanks: Number of voters who left a blank or spoiled vote

l

OverVotes: Number of voters who voted for too many candidates

l

UnderVotes: Number of votes not cast
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The OverVotes and UnderVotes attributes are an indicator of how well the voting process was
understood. Each voter gets to vote for up to 10 candidates (out of 30). OverVotes are those
voters who voted for more than ten candidates. UnderVotes are the number of votes that could
have been cast, but were not (for example, the voter only voted for five candidates).
2) Start Workbench
Start Workbench and open the starting workspace. It already has Readers and Writers added to
handle the data; all we need to do is carry out the transformation:

3) Add FeatureMerger
The first task is to merge the statistical election data onto the actual features. We'll use a
FeatureMerger transformer to do this (more on this transformer appears later in this course).
Add a FeatureMerger transformer. Connect the VotingDivisions data to the Requestor port, and
the Councillors (result) data to the Supplier.
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4) Set Parameters
Click the cog-wheel icon to open the FeatureMerger parameters dialog. For both the Requestor
and Supplier join fields, click the drop-down arrow and choose the Division attribute. This is the
common key by which our data is merged:

Click the OK key to close the dialog.
5) Add Inspector Transformer
Add an Inspector transformer after the FeatureMerger Merged output port. Run the workspace.
Ensure that the Feature Count on that connection is the same as the number of incoming
features from the VotingDivisions (note, there will be extra features from the Councillors data
that is not used, because that includes divisions outside our area of interest).
Also examine the data in the FME Data Inspector to ensure all division polygons now include a
set of attribute data copied from the Excel spreadsheet:
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6) Add AttributeRenamer
Now that we have the numbers we need, we can start to calculate some statistics. To do this
we'll use an AttributeRenamer transformer to first calculate voter turnout percentage for each
division. Place an AttributeRenamer transformer after the FeatureMerger and open the
parameters dialog.
Set the New Attribute to Turnout (to match what we have on the destination schema).
Under 'Default Value', click the down-arrow, and select 'Open Arithmetic Editor.' In the
expression window set the expression to:
(@double(@Value(Votes))/@Value(Voters))*100
You don't need to type this in - the @Value(Votes) and @Value(Voters) part can be obtained by
double-clicking that attribute in the list to the left, as can the @double function. The purpose of
the @double function is to ensure the operation is carried out in floating point and not as
integers.
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Click OK to close the dialog. If you wish you can reconnect an Inspector and re-run the
translation, to see what the result is.
7) Add another attribute to the AttributeRenamer
Using a similar technique, use the AttributeRenamer to calculate the number of UnderVotes per
voter and put it in an attribute that matches the output schema. The expression will be
something like:
@double(@Value(UnderVotes))/@Value(Voters)
8) Add AttributeRounder
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It's a bit excessive to calculate our statistics to 13 decimal places or more. We should truncate
these numbers a bit.
Place an AttributeRounder transformer.

Open the parameters dialog. Under Attributes to Round select the newly created Turnout and
UnderVoting attributes. Set the number of decimal places to 2:

Click OK to close the dialog and, again, run the workspace to check the results if you wish.
9) Connect Schema
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For the final step let's connect the AttributeRounder to the output schema. Simply make
connections from the AttributeRounder to both writer feature types:

Run the workspace and examine the output in Google Earth to prove it has the correct
attributes and is in the correct location.
The project is done, but the output is very plain. It would be much better to improve
the look of the results and there are several ways to do this with KML. We could
simply color the voting divisions differently according to their turnout/overvotes, but
a more impressive method is to use three-dimensional blocks.
10) Add 3DForcer
Add a 3DForcer transformer. This will elevate the feature to the required height. Open the
parameters dialog and press the down-arrow, and select 'Open Arithmetic Editor'. The height of
each block should be proportional to the turnout for that division. To exaggerate the scale,
multiply to Turnout attribute by a value of 50 (see image below).
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11) Add KMLPropertySetter
Add a KMLPropertySetter transformer. This will allow us to set up the 3D blocks in the output.
Open the parameters dialog. Set:
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l

Altitude Mode: Absolute

l

Extrude: Yes

12) Add KMLStyler
Finally add a KMLStyler transformer. The workspace will now look like this:

Open the parameters dialog. Select a color and fill color for the features. Increase the fill
opacity to around 0.75.
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Save and run the workspace. In Google Earth the output should now look like this:

These 3D blocks will show users where the voting turnout is high/low in the city.
If you wish, repeat these steps to give a 3D representation to the UnderVoting statistics.

Congratulations! You have now completed the exercise for this chapter.
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Chapter 3 - Best Practice
In a corporate setting, it’s not enough just to know FME
functionality and terminology. It’s also important to use
FME in a manner that is both efficient and scalable.

What is Best Practice?
In general terms Best Practice means the best way of doing something; in other words,
carrying out a task in the most effective and efficient manner.
Despite the word ‘best’, we’re not presuming the ideas here will meet every need
and occasion. The best description of this concept I’ve heard – and one that fits well
here – is:
“a very good practice to consider in this situation based on past experience and
analysis”
In this manual we’ll cover four different categories of Best Practice.

Methodology
This section covers which techniques make efficient use of Workbench and its components; and
which don’t! Using Workbench the right way makes for a more productive and efficient
experience.

Style
This section is a guide to the preferred design for workspaces. The correct style makes a
workspace easier to interpret, particularly in the long run when the author might return to it
after a period of inactivity.

Debugging
This section covers tools and methods to help identify and fix problems in translations.

Organization
This section covers what functionality exists to organize FME within a workplace. Sharing
resources among several FME users is one technique made possible by special FME
functionality.
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Each section will have a number of recommendations. These are suggested methods
that meet the principles of best practice in FME.

Chapter 3 - Best Practice

133

FME Desktop Location Intelligence Manual

Methodology

Using Workbench the right way makes for a more
productive and efficient experience.

Format Methodology
Format best practices mostly involve setting up readers and writers in a clear and uncluttered
manner in the workspace canvas.
Minimizing Feature Type Objects
A schema definition may contain many, many Feature Types. If these are all listed separately
then the workspace can become extremely unwieldy and poorly laid out.
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When creating a workspace you’ll be prompted which feature types to add to the
canvas. Don’t add feature types you don’t need, as it will clutter the canvas.
Minimizing Source Attributes
Excessive attributes can also cause workspace clutter. This can be relieved using some
functionality to hide (unexpose) unwanted attributes.
This functionality can be found in a Reader Feature Type Properties dialog:
For example, here the user has hidden a number of attributes that are unnecessary for their
workspace. Only the required attributes remain exposed:

This makes the source schema, and all transformer dialogs, much clearer and tidier than if the
entire set of attributes was still exposed.
Hide any attributes you don’t need to use in the translation. It will make the
workspace tidier and Workbench will even perform faster.
Format Defaults
Each Reader and Writer parameter has a default value when FME is installed.
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However, a user may find they change a parameter regularly whenever a new workspace is
created. For example, if they always connect to the same Oracle host, it would be useful to
store the server name so that any new Oracle reader or writer automatically contains the
correct connection parameters.

Best practice suggests that the Format Defaults options be used whenever the format settings
dialog is opened; for example, through the parameters button in the New Workspace dialog.
Now whenever a specific format is used, the parameters already have predefined defaults.
For example, a user of the ArcGIS Online Service format may want to use a specific host,
username, and password quite frequently.

By saving these values, whenever an ArcGIS Online Reader is added to a workspace its default
host/username/password are always the same as what was set.
Of course, it may not be best practice to store default passwords inside a workspace. Users will
want to consider the time-saving benefits against the potential security risks.
If you create the same workspace repeatedly, then use the Defaults options to avoid
having to enter the same parameter values each time.
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Transformer Methodology
As part of the business of creating translations, there are a number of ways to use FME in an
efficient and skillful manner. Some of these apply specifically to the use of transformers.
The Right Transformer
Although there are usually several ways to achieve the same goal with different transformers,
the methods are not always equally efficient. It’s important not to assume that the first way is
the best way.
If a workspace duplicates the same transformer again, and again – or divides data up into
multiple streams to process it only slightly differently – then it is probable that the workspace
has been designed very inefficiently.
The multiple attribute transformers here indicate there is a problem.

If you’re unsure as to what transformer to use, or are worried that your workspace
has multiple streams of data for no good reason, then consult other users in the FME
community, or the Safe Software support team.
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Default Values
As with reader and writer dialogs, transformer parameter dialogs also possess a button to set
the current values as future defaults.
In this parameters dialog for the AreaBuilder transformer, the Defaults button is highlighted.
By entering a set of values and saving them as the current defaults, each newly placed instance
of this transformer inherits the same parameter values.

Multi-Workspace Translations
Although FME has the capability to run one workspace from another – using the
WorkspaceRunner transformer – this is designed for the specific situation of batch processing.
In most other cases a user should never need to split a translation over two or more
workspaces.
If you’re in a situation that requires the use of two workspaces to carry out one
translation, then reconsider your decision and consult other FME users for advice.

Workspace Scale
You might have noticed view tools for zooming in and out of a workspace, but did you know that
there is a default zoom scale (100%) at which transformer are shown in “actual size”?
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To revert to this optimum zoom level you can either drag the scale bar to 100% or double-click
anywhere on the scale bar.

Working with a 100% zoom is the optimum scale for viewing FME canvas objects.
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Style

A well-styled workspace provides many benefits as it is
developed and edited in the future.

An FME Workspace Style Guide
Workspaces are rarely static or used repeatedly without being edited; sooner or later the
source or destination schema will change, or edits will be needed to take advantage of new or
updated FME functionality.
A good style of design makes it easier to navigate and understand an existing workspace, and
thus simplifies the editing process. It’s very much like a computer programmer adding
comments to explain his actions. As an example, nearly 30% of FME’s codebase is comment
lines.
Specifically, a good style can help a user to…
l

Distinctly define different sections or components of a workspace

l

Quickly navigate to a specified section or particular transformer

l

Pass a workspace on to another user for editing

l

Rename workspaces and content with a more explanatory title
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Example of Poor Design

Who would envy a user given the task of editing this workspace?
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Annotating Workspaces
Annotation is a key method for a clear and comprehensible design.
Annotation helps other users understand what is supposed to be happening in the translation
and also helps the creator when returning to a workspace after a long interval (take it from me
that this is especially important!)
There are a number of different types of annotation that can be applied to a workspace.
Default Annotation
By default FME adds three annotations to a newly-created workspace. The annotations are
basic comments that indicate the source data, the transformation, and the destination data.
They can be deleted or, optionally, left ungenerated, and therefore may not appear in every
workspace.

Summary Annotation
Summary annotation is an FME-generated comment that provides information about any object
within the workspace. This item can be a source or destination feature type, or a transformer.
Summary annotation is always colored blue to distinguish it from other annotation. It’s always
connected to the item to which it relates and cannot be detached.

The nice thing about Summary Annotation is that it automatically updates in response to
changes. It’s also useful in situations where the transformer parameters are set through a
wizard (for example, the SchemaMapper or FeatureReader) and would take longer to check
that way.
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Aunt Interop says…
‘Size doesn’t matter! You should always use Best Practice on small
workspaces and training exercises – as well as large scale projects
– to get into the habit and to make them scalable.’
User Annotation
User annotation is a comment created by the user. It can be connected to a particular
workspace object or float freely within the workspace.

To create floating user annotation, right-click the canvas and select Insert Annotation.
To create attached user annotation, right-click a workspace object and select Add Annotation.

When you place an annotation you now have the
opportunity to change the font style, font size, and
background color; plus you can also add hyperlinks,
bullet points, and tables. This functionality is brand
new for FME 2014.

Create user annotation on nearly all transformers, to help future edits and updates
go more smoothly.
Annotation Options
Right-click an annotation object to reveal (among other things) the following options:
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l

Set Background Color - change the background color of the annotation

l

Word Wrap - Toggle word wrapping on and off

l

Follow Attached Object – make the annotation move when the attached object is
moved

l

Attach to Feature Type – attach to a specific feature type

l

Attach to Transformer – attach to a specific transformer

l

Attach to Connection – attach to a specific connection between two objects

l

Detach – detach annotation from an object

Bookmarks
A bookmark, like its real-world namesake, is a means of putting a marker down for easy
access.
With FME the bookmark covers an area of workspace that is usually carrying out a specific
task, so a user can pick it out of a larger set of transformers and move to it with relative ease.
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Why use Bookmarks?
Bookmarks play an important role in a well-styled workspace for a number of reasons,
including these.
l

Sectioning: For dividing up a workspace into different - clearly marked - sections.

l

Quick Access: For placing a marker for quick access to a certain part.

l

Organization: For moving about sections of transformers at a time.

Adding a Bookmark
To add a bookmark, click the Bookmark icon on the toolbar.

Whereas a traditional bookmark marks just a single page in a book, the FME bookmark can
cover a wide area of the canvas. A single workspace can be divided into different sections by
applying multiple bookmarks.
If any objects on the workspace canvas are selected when a bookmark is created,
the bookmark expands to include those items.
Resizing and Editing a Bookmark
To resize a bookmark simply hover over a corner or edge and then drag the cursor to change
the bookmark size or shape.
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Double-clicking a bookmark title allows the color and title of the bookmark to be edited.
Bookmarks are shown either as a frame around white-space or filled with color.
Tools > FME Options on the menu bar opens a dialog with a number of sections,
one of which (Workbench) has an option to have color-filled bookmarks.

Bookmark Options
Right-click a bookmark to show the following options:

l

Delete: Delete the bookmark

l

Duplicate: Create a duplicate bookmark

l

Rename: Edit the bookmark title.

l

Edit Bookmark Description: Edit the description of the bookmark.

l

l

Select All Objects in Bookmark: All objects (transformers included) in the bookmark
are selected.
Properties: Open a dialog to set bookmark name and color.
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A bookmark description shows as a block of
text inside the bookmark. Like annotation, it
can be styled to a specific font or color.

Bookmarks for Sectioning
A bookmark is a great way of indicating that a particular section of a workspace is for a
particular purpose. By subdividing a workspace in this way, the layout is often a lot easier to
follow. Think of bookmarks as being like the chapter headings in a book!
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This workspace illustrates nicely how to mark up different sections of a workspace using
Bookmarks.
If you use bookmarks for nothing else, use them to divide your workspace into
easily identifiable sections. It really makes the canvas more readable.
Bookmarks for Quick Access
If a workspace is sectioned with bookmarks, they can be used to navigate to a particular
section.
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Bookmarks are listed on the Workbench Navigator.
Clicking a bookmark here selects that bookmark and brings it into view.
Double-clicking it selects the bookmark and brings it into the centre of the view.
Right-clicking it shows the same options as right-clicking a bookmark on the canvas.
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Bookmarks for Organization
A bookmark ‘magnet’ is a toggle that has a status represented by the icon shown in its top-left
corner.
The default status of a bookmark magnet is active. Clicking the icon lets a user de-activate or
re-activate the magnet.
This feature aids in organizing a workspace because an active magnet (red) causes objects on
the canvas to move as the bookmark is moved. Therefore large groups of transformers can be
moved about the workspace canvas to create a clearer layout.
An inactive magnet (blue) allows the bookmark to be moved without disturbing the contents,
which is also useful in some situations.

Mr. E. Dict (Attorney of FME Law) says…
‘In my considered opinion, it’s perfectly legal to nest bookmarks.
Nesting means to place one bookmark inside another. In this
manner each ‘section’ of a workspace can be divided into
subsections.’
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General Style Suggestions
These items are general suggestions for what the style of an FME workspace should look like.
Non-Overlapping Connections
Does it really need to be said that overlapping lines are not good for workspace clarity?
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Take the effort to tidy your workspace. It will be so much clearer with just a little
reorganization.

Renamed Transformers
Remember that the Properties dialog for a transformer contains a field where the transformer
may be renamed to a more meaningful title.

Chapter 3 - Best Practice

152

FME Desktop Location Intelligence Manual

Rename transformers to help identify them both on the canvas and in the navigator
window.
Transformer Layout
The layout of transformers – and, in particular, a consistent method of positioning – can really
make the difference between a poorly-designed workspace and one that is visually attractive
and efficient.

Try to line up objects where possible and use the minimum of backwards-pointing connections
(those that go from right to left):
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Using straight connection lines between objects – rather than crooked - is one way to
enhance the look of any workspace.
Some users prefer to add extra vertices to connections to square them off.

Try to avoid adding extra vertices to a connection line, because their behavior is
unpredictable when you move one of the attached transformers.

Objects in a stack - particularly feature types - are easier on the eye when vertically aligned.
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A toolbar button (Align Vertical Centers) will do this; and there are similar tools for aligning
horizontally, or spreading objects at an equal distance apart.
Exercise 3a Applying the Style Guide
Scenario

FME user; City of Interopolis, Planning Department

Data

City Parks (MapInfo TAB)

Overall Goal

Clean-up workspace and apply concepts of style guide

Demonstrates

Style Best Practice

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3aBegin.fmw

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3aComplete.fmw

Look at the workspace you created for the exercises in Chapter 2. Does it look like this? It
should... once you've completed this exercise!
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1) Open the Workspace
Open the finished workspace for the exercises in Chapter 2.
Alternatively open C:\FMEData2014\Workspaces\DesktopBasic\Exercise3aBegin.fmw
2) Tidy the Workspace
Tidy the workspace layout and setup using the FME Style Guide covered in the previous pages.
Don’t forget to use annotation and bookmarks, so that future users of the workspace will be
able to tell at a glance what the workspace is supposed to do.

Why use Best Practice?
Best Practice in FME can help a user to…
l

Create well-styled workspaces that are self-documenting

l

Create workspaces that use the correct functionality in the correct place

l

Create high-performance workspaces

l

Use FME Workbench in a way that’s most efficient

l

Debug a workspace when it doesn’t work the way intended

l

Use FME in a project-based environment

Dr. Workbench says...
‘I learned about Best Practice the hard way, when I was tasked with surgery on a set
of someone else’s workspaces. They were so badly organized the whole operation
took me three times as long as it should have taken.’
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Debugging

Even skilled FME users seldom produce correct results
with the first version of a new workspace.

In the event of an error message or unexpected output, a user must ‘debug’ the workspace to
find what error has been introduced into the workflow definition. And when the workspace is
very large, debugging can be as much an art as a science.

Logging
The log window contains a record of all stages and processes within a translation. The contents
may appear complex, but such information is vital for interpreting a workspace’s actions.
Message Types
There are a number of different message types that show in the log window including:

Chapter 3 - Best Practice

157

FME Desktop Location Intelligence Manual

l

An error in the log window, denoted by the term ERROR, indicates that a problem has
caused FME to terminate processing.
Example: An inability to write the output dataset because of incorrect user
permissions.

l

A warning in the log window, denoted by the term WARN, indicates a processing
problem. The problem is sufficiently minor to allow FME to complete the translation,
but the output may be adversely affected and should be checked.
Example: An inability to write features with a geometry that’s incompatible with the
Writer format. FME can filter out these features, but will warn the user of their
presence.

l

Information messages, denoted by the term INFORM, indicate a piece of information
that may help a user determine whether their translation has been processed
correctly.
Example: The number of features processed by a transformer or confirmation of a
particular dataset parameter.

l

Statistics messages, denoted by the term STATS, provide information on the number
of features read from the source and written to the destination datasets.
Example: The number of features processed by the workspace as a whole and the
time taken to do so.

You can search for different types of messages by clicking in the log window and
pressing Ctrl+F to open a search dialog.

Log Options
Workbench has the ability to filter different message types from the log window. This is done
using Tools > FME Options > Runtime.
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Adjusting the view of messages in this way does not affect the output written to the log file.

Turning off STATS and INFORM log messages helps to
highlight WARN and ERROR messages in the log so there is
less chance of missing them; though it does feel strange to
watch a translation take place without the log window
scrolling past as usual!

Log Timings
Another useful option under Tools > FME Options > Runtime is the ability to turn log
timestamp information on or off.
Log timestamps indicate the absolute date and time for each step of the translation process.
They also show the time taken by FME to process the previous stage and the cumulative time
taken to reach that point in the translation.
Keep log timings turned on. They do add to the amount of content in the window, but
can be very useful when trying to debug a poorly-performing translation.
Interpreting the Log Window
It can’t be emphasized enough that the log window is THE most important place to look for
information when a translation does not complete as expected - or to be sure that a translation
has completed as expected.
If a translation fails, look in the log window first.
Rejected Features
When a transformer rejects a feature in some way – perhaps it has the wrong type of
geometry, for example – it usually writes it to a spatial log file.
Identify bad features using the spatial log (.ffs) dataset. It will probably be easier
than trying to locate the feature within the full source dataset.
Here are some tips on interpreting the log file:
Check for Warnings
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The first thing to do is check for the following comment:
Translation was SUCCESSFUL with X warning(s)

And then (if X > 0), use the search option to look for the word WARN
Sequence
Be aware that — because FME processes data feature-by-feature instead of transformer-bytransformer — the log file does not show each transformer in sequence. Don't be fooled into
thinking the order of the log file will absolutely match the layout of the workspace.
Output
If the workspace writers have been redirected to an output other than a destination dataset,
then this is reported at the very bottom of the log. Watch for such messages. It’s easy to miss
this and assume that there is a problem with the FME writer.
Timestamps
Literally, FME processing time is the amount of time that FME was actively processing. This is
not necessarily the same as the length of time taken to run the translation!
The absolute start and end times often differ from FME processing time because non-FME
processes, such as a database query, add to the absolute time taken without adding to the FME
processing time.
Therefore the log can provide an indication of the efficiency of external processes; for
example, database reading. A slow database read would imply database indexing needs to be
improved.
Unexpected Input
Unexpected Input is data that is read from a dataset but not used in the workspace. This is
reported through a message at the bottom of the log. However, don’t automatically assume
that there is a definite problem. FME will report this as a warning even if a user deliberately
didn’t want this data processed.
Filtering Rejected Input
Occasionally a transformer or writer will reject certain features because they do not match the
functionality or parameters of that object.
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For example, if a mixture of point and line features is sent into the AreaBuilder transformer,
then the log will report that the point features were discarded.
It will give a tidier log if such features are removed before they get to the point of being a
problem. For example, a GeometryFilter would be enough to filter out points before they even
get to the AreaBuilder.
Logger Transformer
A Logger transformer takes features from the workflow and writes information about them to
the log window or log file. Limits can be placed on the number of features to be logged in full.
It is extremely useful for writing out information to the log for debugging purposes.
The Logger transformer has a setting called ‘Log Message:’ – when a feature is
logged, this message appears with it. Setting a unique message helps you locate
logged features by using the log search function to find the message. FME also adds
the transformer name to the message, helping you to identify between multiple
Logger transformers.

Feature Counts
A workspace Feature Count refers to the numbers shown on each connection once a translation
is complete:

When a log file shows a translation that ended in an error or where the number of output
features was not what was expected, then the Feature Count values shown on each connection
can help to diagnose where the error occurred.
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For example, if all your features entered a transformer, but none emerged, then you can be
fairly confident that the transformer is the cause of the problem. You might check that the
correct transformer output port is connected, or add a Logger or Inspector transformer before
it so that you can examine what data is going in and determine why it is being lost.
Here, for example, 100 features are entering the Clipper transformer (to be clipped against a
single boundary) but none emerge.

Maybe this is because the wrong output port is connected and the data falls outside the clip
boundary and not inside. If this itself would be a problem, then inspect the data as it enters the
transformer to ensure both Clipper and Clippees occupy the same coordinate system.
Single Feature Counts
When a workspace fails (usually with an ERROR) and only a single feature has emerged from a
transformer, it is likely to be the following transformer that is the cause of the problem:

Here, for example, 100 features enter the StatisticsCalculator and only 1 emerges. However,
the StatisticsCalculator is not the source of the error. The error is triggered when the first
feature exits the StatisticsCalculator and reaches the VertexCreator, suggesting the
VertexCreator is the problem here. It failed before the other 99 features had the chance to
even reach it.
Use Feature counts to identify where a problem occurred.
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You should also be clear that these numbers don’t work as well for identifying
warnings. Most warnings still allow the feature in question to pass, unprocessed, so
the counts do not reflect warnings as well as they reflect errors that stop the
translation in its failed state.

Workspace Searching
The workspace search function is accessed through a hyperlink at the foot of the Navigator
window:

Clicking this link opens up a text dialog in which to enter search terms. The results of the
search include any attribute names, feature types, transformers, parameter names, and
parameter values that include the search term entered.
Workspace search is important for debugging because sometimes the transformer that fails
does so because of a fault in a completely different part of the workspace. When that happens,
the ability to search a workspace for terms found in the error message helps to track down the
source of the problem.

Use a Workspace Search to locate items identified as problems in the log. This is
especially useful when the workspace is very large.
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Testing Isolated Sections
Testing and debugging a large workspace is easier when it’s possible to isolate sections and
test them separately. Of course, it will help this technique if the workspace is already properly
divided using bookmarks!
The ability to isolate specific sections is done by disabling connections. This renders a
connection inoperative in much the same way as if it had been deleted, and no features will
pass through.
For large workspaces the disable functionality is very useful. It enables the author to isolate
sections of a workspace from being executed, so that tests run much more efficiently.
Here the workspace has two outputs from the BulkAttributeRemover , creating two separate
parts to the workspace. The user wishes to run the workspace only on one section, so disables
the second connection.

Now no data will be sent to the GeometryFilter for processing in that section.
Connections can be disabled by clicking on them and using the shortcut Ctrl+E. This keyboard
shortcut is a toggle that alternates between enabled and disabled. Alternatively, you can rightclick on a connection and use the disable option.
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As well as connections, you can disable any object on the canvas; for example a
transformer or a feature type.
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Exercise 3b Debugging
Scenario

FME user; City of Interopolis, Planning Department

Data

GPS Road data (JSON)

Overall Goal

Debug workspace

Demonstrates

Debugging Best Practice

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3b-Begin.fmw

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3bComplete.fmw

On his application for FME Certified Professional status, Shirley U Jest
says…
‘’I love driving across bridges! This workspace takes a set of GPS
points, converts them to road lines, and then shows where I drove
across a bridge by clipping it against the Vancouver land boundary’

Unfortunately this jester is seriously in error, and has produced a very poor workspace.
1) Start Workbench
Start FME Workbench and open the starting workspace.
Run the workspace and inspect the error message.
Track down where the error occurs, trace it to its cause, and fix it.
2) Fix Translation
Track down all the other problems in the workspace (I count three or four others) and be sure
to fix them.
Remember to make use of:
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l

The FME Data Inspector

l

The Logger and Inspector transformers

l

Feature Counts

l

Log window WARNings and ERRORs.

Your output should look like this in the FME Data Inspector:

ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

Oh! Looks like I need to get my GPS fixed!
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Feature Inspection
Feature Inspection is a tool that allows individual features to be inspected, one-by-one, during
a translation. As might be imagined, this is very useful for debugging purposes.
Feature Inspection is triggered by Inspection Points; workspace connections that are flagged
by the user as a location where features should be inspected.
Here a user wishes to inspect data after processing by the StatisticsCalculator transformer.
Right click > Inspection Point > Add Inspection Point is used to set it up.

The connection is highlighted blue with a red "stop" sign, to denote its new status. Now the
workspace is run using “Run translation with inspection”
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When the first feature arrives at the inspection point, the translation is temporarily paused and
information about the feature displayed in a Feature Inspector window.

The upper part of the window shows a graphic representation of the feature; the lower part lists
properties such as Feature Type and Coordinate System; plus attribute and geometry
information.
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There are four buttons at the foot of the Feature Inspector window:

Step to Next Link

This tool steps through the workspace one transformer at a
time, showing the status of a feature as it is processed.

Step to Next Inspection
Point

This tool re-starts the translation, stopping the next time a
feature reaches an inspection point.

Continue Translation

This tool re-starts the translation, ignoring all further
inspection points.

Stop Translation

This tool stops the translation.
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The currently active connection is highlighted orange to show it is the location where the
translation is currently paused.
The current connection might be different to the original inspection point when the “Step to
Next Link” tool has been used.

And while feature inspection is going on, the status of the FME process (in the Windows Task
Manager for example) shows that the translation is still actually ongoing.

Use Feature Inspection when a transformation is going wrong and you can’t tell
where, or when you suspect one particular feature is causing a problem. It’s likely to
help less when the problem is a crash or ERROR in the log window.
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Now you've learned about Feature Inspection, why not try the previous example again, this
time using these techniques to show what happens step, by step?
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Organization

A goal without a plan, is just a wish!

A key part to any FME project is to keep organized and combine your efforts with other
colleages by sharing data and resources. Luckily FME has a number of tools that can help you
achieve this.

Sharing Resources
Re-using components, and sharing them with fellow FME users, is vital in creating consistent
designs among a large group of employees. It also improves efficiency – because a translation
author will not have to create every workspace from the beginning – and reliability, because
any change to a shared resource is passed on through any workspaces that make use of it.
Resources that may be shared include workspaces, custom transformers, custom formats,
custom coordinate systems, and templates.
Shared Resource Directories
The basic method of sharing is through a Shared Resource Directory. FME is able to identify
resources stored in these directories, and use them directly within a translation.
A shared resource directory can be used by just one person, or many.
Using a shared directory is as simple as defining it using Tools > FME Options > Default
Paths.
By specifying a location in this option, FME automatically searches for and uses any shared
resources that are stored in this folder.
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Use a shared folder on your network as a shared resource folder when you have
several FME authors who all need access to the same resources.

<user>/<documents>/<FME> is a shared resource directory created and used by
default, without having to define it within the options dialog.

Chapter 3 - Best Practice

174

FME Desktop Location Intelligence Manual

Templates
FME Templates are a particularly useful for of shared resource. Like similarly-named items in
other software, FME templates are a means of creating a workspace with/from a predesigned
format and structure.
The closest analogy is to think of templates as a blueprint design
They have their own extension (*.fmwt) and their own storage folder
(<user>/FME/Templates).
The most interesting thing about FME templates is perhaps that they can include source
datasets within the file. This way both a workspace example, and the data required to run it,
can be bundled together and provided to another user.

What Are Templates For?
Templates have potentially very many uses. The most obvious ones are:
l

A Complete Translation
Wrapping up source data and workspace inside a single file makes it a very elegant
way of providing a set of related files to another user.

l

Pre-Defined Data
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When a series of workspaces are all to use the same source or destination data, a
template allows the author to duplicate Readers and Writers without having to
recreate the workspace each time.
l

Pre-Defined Transformation
Templates are a great way to store a set of processing tasks for re-use. The enduser can simply create a workspace from the template and add their own readers
and writers.

l

An Example Translation

FME Projects
FME is often used not just for one-off translations, but for a particular project or series of
projects.
Project best practice involves suggestions more than hard and fast rules; but suggestions that
are highly recommended!
Directory Structure
Project use of FME is more efficient when a proper project structure is maintained.
For example, assuming a special disk for storing projects (P:), a simple project structure could
be:
myproject\

Use a project ID if you have one; for example:
P:\P2013-999_PROPERTY_UPDATES

Follow this with subdirectories, such as:
.\FMEworkspaces
.\includes
.\Scripts

which could itself have subdirectories such as
for include files
for Python, SQL, or Tcl scripts

.\SourceData

for storing source dataset files

.\OutputData

for storing destination dataset files

.\NoteDocs&Stuff
.\testing

project estimates, specifications, proposals, scope of work, and so forth
a folder for test data and workspaces
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For a large scale FME project, set up a project structure and stick to it. Keep copies
of all FME workspaces, maybe in a revision control system like Subversion.
File Naming
Based on past experience the Safe Professional Services team has the following
recommendations for file and folder naming within an FME project:
l

Use revision numbers on workspaces or directories; for example, myworkspace_
rev17.fmw.
It's tempting to save to the same workspace all the time, but then there is no fallback
position from a mistake or corrupt workspace. It only takes one such mistake to regret
it.

l

When using dates for file names or directories, use international dates such as 2013-0321 or 20130321 so files are listed in the correct order. Do not use a date such as Mar-2113, which will be listed alphabetically after April in Windows Explorer.

l

Reduce clutter in the project’s main directory by saving files inside subdirectories.

l

Avoid meaningless directory and files names, such as ‘fr_clnt’. From Client? Father Clint?!

l

Share ideas with others. Make sure all users conform to the same conventions.

Relative Paths
Although it isn’t possible to browse for a relative path, it is possible to manually edit a path to
be relative; for example, change P:\P2013-999\SourceData\myfile.dgn to
.\SourceData\myfile.dgn.
The advantage of doing this is that if the original project is renamed or even moved to a new
location, all of the workspaces will still function correctly without further editing.
Exercise 3c Using a Template
Scenario

FME user; City of Interopolis, Planning Department

Overall Goal

Download and use a template

Demonstrates

Organization Best Practice

Starting Workspace

None

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3cComplete.fmwt
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As a little practice, open the Create Workspace dialog and experiment with opening and using a
template. It can either be an installed template or one from the FME Store.
Then take a previous workspace and convert it into a template.
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Module Review

This module was designed to help you use FME
Workbench in the most efficient manner, to effectively
manage FME related projects, and to ensure those
projects are scalable and portable.

What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
l

l

Best Practice is the act of using FME in a manner that is efficient, but also easily
comprehensible by other FME users.
Best Practice in FME can be divided into Methodology, Style, Performance,
Debugging and Organization.

FME Skills
l

l

l

l

The ability to use Workbench in the right way, so as to provide maximum efficiency and
productivity.
The ability to use bookmarks, annotation, and workspace settings to apply a welldesigned workspace style.
The ability to interpret an FME log file at a basic level and to use debugging techniques to
locate problems in a translation.
The ability to use FME as part of a larger project, in an organized and efficient manner.
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Best Practice
Exercise 3d Best Practice
Scenario

FME User Conference Attendee

Data

Roads (DWG, Shape)

Overall Goal

Find route from user conference to sports bar

Demonstrates

Data translation, data transformation, best practice

Starting Workspace None
Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise3d-Complete.fmw

In this exercise you are an attendee at the FME International User Conference 2014. After a full
day of learning about FME at the Vancouver Convention Centre you and some colleagues want
to go and watch a World Cup soccer game on TV somewhere. The Safe Software staff tell you
the best experience would be at an Italian cafe on bustling Commercial Drive, but they neglect
to tell you how to get there.
So, your task is to use the data available to you to calculate the best route from the convention
centre to Commercial Drive, and to write out that data to GPX format so you can use it in your
in-car navigation/GPS.
1) Inspect Data
Start the FME Data Inspector and open the two datasets we will be using:
Reader Format:
Reader Dataset:

Autodesk AutoCAD DWG/DXF
C:\FMEData2014\Data\Transportation\Roads.dwg

Parameters
Group Entities By:

Attribute Schema

Reader Format:
Reader Dataset:

Autodesk AutoCAD DWG/DXF
C:\FMEData2014\Data\Transportation\OneWayStreets.dwg

The main dataset is the roads DWG file, though we'll also need to know which roads are oneway if we want to calculate a route that is actually legal!
If you have a background map applied, try to locate both the Vancouver Convention Centre and
Commercial Drive.
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ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

2) Start Workbench
Start Workbench and use the option to Generate a workspace.
Reader Format:
Reader Datasets:

Autodesk AutoCAD DWG/DXF
C:\FMEData2014\Data\Transportation\Roads.dwg
C:\FMEData2014\Data\Transportation\OneWayStreets.dwg

Parameters
Group Entities By:
Writer Format:
Writer Dataset:

Attribute Schema
GPS eXchange Format (GPX)
C:\FMEData2014\Output\Training\DrivingRoute.gpx

The Reader is simple enough to set up - just select both DWG files when you browse for the
data.
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Select all feature types when prompted (we need all roads) and the workspace will look like
this:

For the sake of Best Practice, you may want to put a bookmark around these features, and
maybe annotate which are the one-way streets.
3) Add ShortestPathFinder
Now we need to start calculating a route. The obvious first step is to add a ShortestPathFinder
transformer, which is how we can calculate our route.
So, add a ShortestPathFinder transformer. Connect all of the street feature types (except
OneWayStreets) to the Network port.
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4) Add Creator
The other input port on the ShortestPathFinder is for the From-To path (the start and end points
of our journey). To add a feature to input here we can manually create it with the Creator
transformer. Add a Creator transformer and connect it to the From-To port. Open the Creator
parameters dialog.
Firstly enter UTM83-10 as the coordinate system of the data we are about to create.
For the Geometry Object parameter, click the [...] browse button to the right to open a
geometry-creation dialog. Select Line as the geometry type and enter the following
coordinates:
X 491500 Y 5459550
X 494500 Y 5457440
The first coordinate is that of the convention centre and the second is the closest point in our
network to Commercial Drive.
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Click the OK button to close the dialog.
5) Check ShortestPathFinder Parameters
The coordinates of the feature we've added might not sit exactly on the road network. To get
around this issue there are parameters we can use in the ShortestPathFinder.
So, open the ShortestPathFinder parameters dialog. Under Snap Options set From-To Snapping
to Yes and enter 150 as the Snapping Tolerance:

Also notice that there are parameters for network costs - we'll be making use of those later.
6) Run Workspace
Add some Inspector transformers after the ShortestPathFinder and run the workspace to prove
it is working up to this point.
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If all has gone well, the output will look like this, with a route defined:

ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

Of course, if all has not gone correctly, you must make use of Inspector and Logger
transformers, plus Feature Inspection, to try and locate the error.
7) Add ChangeDetector
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The result looks fine, but there are some things we are yet uncertain about: what if the route
takes us the wrong way down a one-way street; and what if it uses slower, residential routes?
The first issue we can solve by matching up one-way streets so we can remove them from the
network.
Add a ChangeDetector transformer to the workspace. Connect all of the road feature types to
the Original port and the OneWayStreets feature type to the Revised port:

Open up the ChangeDetector parameters. Note that we are matching geometry (correct) so
don't change any parameters, just click OK to close the dialog.
By using the ChangeDetector road features that match a one-way street will emerge from the
Unchanged port, so we should leave this unconnected. Similarly, Added features will be oneway streets that haven't been matched, and we can leave these out too.
So connect the Deleted port to the ShortestPathFinder Network port. The "Deleted" features are
those that the transformer thinks have been deleted because they exist as roads, but not in the
one-way data.
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8) Re-Run Workspace
Now re-run the workspace. Check the new route. If it has changed from before then you know
this is because it is now avoiding one-way streets. This might not be the shortest route, but it's
one we can confidently follow without heading directly into incoming traffic!
9) Add AttributeValueMapper
To weight our route in favour of arterial roads (not residential) we need to give each type of
route a cost. We could connect an AttributeCreator to each road type, but you can see from this
screenshot how badly designed this would look:

Far better is to use an AttributeValueMapper, so place one of these transformers into the
workspace. After the ChangeDetector will be best, as then some features will have already
been filtered out and this transformer will have less work to do.
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Open the parameters dialog. Notice that we need a Source Attribute by which to identify road
type. As we don't have one (yet) close the dialog and we'll rectify that problem.
10) Add AttributeExposer
With any translation FME adds an attribute - called fme_feature_type - to identify the layer
each data originated on. By default this attribute is hidden, but we can expose it with an
AttributeExposer transformer.
So, add an AttributeExposer transformer before the AttributeValueMapper. Open the
parameters dialog. Double-click in the first field and you should be able to use a drop-down list
to find fme_feature_type and select it.

11) Fix AttributeValueMapper
Now we can set up the AttributeValueMapper transformer. Open its parameters dialog:
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Select fme_feature_type as the Source Attribute
Enter Cost as the Destination Attribute
Enter 2 as the Default Value.

Now, underneath those parameters, we'll map some data.
Enter "Arterial" into the first Source Value field and a value of 1 in the matching Destination
Value.
Enter "Residential" into the second Source Value field and a value of 3 in the matching
Destination Value.

Basically, if the route is arterial (a main road) it will get a cost of 1; residential routes will get a
cost of 3 and all other types will get a cost of 2. Click OK to close the dialog.
12) Now we'll apply that newly calculated cost in the ShortestPathFinder. Open the
ShortestPathFinder parameters dialog. Set the Cost Type parameter to be "By Two Attributes".
Select "Cost" as the attribute for both the Forward and Reverse cost parameters.
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13) Run Workspace
The workspace will now look like this:

Save and then run the workspace. You'll find that your new route directs you from the
convention centre to Commercial Drive avoiding one-way streets and taking the slowness of
residential routes into account.
14) Connect Schema
Oh! Don't forget to remove the Inspector transformers and connect the Path port to the Route
output feature type:
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Now run the workspace, upload the data to your GPS device, and you are ready to go!
Not really advanced, but you did use Best Practice throughout, right? I mean, you
have bookmarks and annotations where needed, and no overlapping connections? If
not, well you might want to fix that!

Congratulations! You have now completed the exercise for this chapter.
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Chapter 4 - Readers and Writers
An FME translation is made up of a number of different
components.

There are many different components that go to make up a translation.
For each component there are tools within FME to create, add, or remove them; and
parameters in Workbench in order to control them.
In particular, each component has very specific terminology applied to it, and it’s useful to
have a full understanding of this terminology, especially when working with multiple datasets.
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Key Components

An FME translation is made up of a number of
different components.

The list of key components in an FME translation is as follows:
l

Workspace

l

Readers and Writers

l

Feature Types

l

Features

It’s important to notice that all these components exist in a related hierarchy.
Hierarchy is an important concept because it affects how components are added to a
translation, and - more importantly - how they are controlled.
This section covers “official” FME components only.
For example, it won’t cover any user-defined Python scripting that might be used to
exert control over several workspaces.
However, it’s easy to look at this hierarchy diagram and imagine where such custom
components might fit it.

Workspace
A workspace is the primary element in an FME translation and is responsible for storing a
translation definition. A workspace is held as a file with an .fmw file extension. It can be run in
either the Quick Translator or FME Workbench, but can only be opened for editing in
Workbench.
Think of a workspace as the container for all the functionality of a translation.
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Readers and Writers
A Reader is the FME term for the component in a translation that reads a source dataset.
Likewise, a Writer is the component that writes to a destination dataset.
Each reader and writer in a workspace handles just a single format of data. To read or write
multiple formats requires the use of multiple readers and/or writers.
It's important to note that Readers and Writers don’t appear as objects on the
Workbench canvas.
Instead they are represented by entries in the Navigator window. Each reader and writer
appears as a separate entry in the list.

Each item in the Navigator window is represented by an icon. The icons for readers and writers
look like this:

The format of each reader and writer is denoted by the format keyword. In this example the
reader format is SQL Server Spatial, and the writer format is PostGIS.
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The “MySourceData” and “MyDestinationData” parts of the screenshot are the names of the
datasets being read/written. When multiple datasets are read they are all listed, like in this
AutoCAD reader.

Feature Types
Feature Type is the FME term that describes a subset of records. Common alternatives for this
term are ‘layer’, ‘table’, ‘feature class’, and ‘object class’. For example, each layer in a DWG
file is defined by a feature type in FME.
Feature Types are represented by objects in the Workbench canvas. The important part here is
that each feature type belongs to a Reader or Writer defined in the Navigator
window.
Therefore, when reading data, the Navigator window defines what dataset is being read, and
the canvas objects define what layers are being read from that data. If a specific layer is not
defined by a feature type, then that data will not be either read and/or written.
Don’t confuse the term ‘Feature Type’ with ‘Geometry Type’.
Feature Type means “layer”; Geometry Type means “lines”, “points”, “polygons”.
In this workspace, feature types represent layers of source data called Roads, Rail, and Rivers.
The workspace canvas contains a different object for each feature type in both reader and
writer.
If there was a layer in the source data called Vegetation, then it would be discarded from the
translation because it doesn't have a matching feature type.
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Beside canvas objects, feature types can be found listed in the Navigator window. They are the
only component to be listed in two places in this way.

Here both Reader and Writer have feature types for Buildings, Rail, Rivers, Roads, and
Schools; and feature type objects for these would be found in the workspace canvas.
Features
Features are the smallest single components of an FME translation.
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They aren’t individually represented within a workspace, except by the feature counts on a
completed translation.
Here 42 road features were translated.

One-To-Many Relationships
The hierarchical relationship between workspace, readers, writers, feature types, and features
is always one-to-many (1:M) with the level beneath:

Chapter 4 - Readers and Writers

198

FME Desktop Location Intelligence Manual

Notice how a single workspace can contain any number of readers and writers, each reader can
contain a number of feature types, and each feature type can contain any number of features
within it.
This means that a single workspace can read and write any number of different datasets and
data types, each of which can have its own unique set of feature types. Each feature type will,
usually, contain multiple features.
Managing Components
FME has a number of tools for managing components in an FME translation:
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l

Create Workspace

l

Add Reader/Writer

l

Add Feature Types

l

Import Feature Types

l

Remove Reader/Writer

l

Remove Feature Types

l

Update Feature Types

l

Move Feature Types

Controlling Components
Each component has a set of settings that control how the component behaves when the
translation is run. In FME terms we call these Parameters and, like transformers, each
component has its own set of parameters that control its actions.

Chapter 4 - Readers and Writers

200

FME Desktop Location Intelligence Manual

Workspaces

A workspace is a file responsible for storing a translation
definition.

Workspaces are the primary containers of translation components. At the top of the hierarchy
they can contain any number of Readers, Writers, and feature types; or sometimes none at all!

Creating a Workspace
A workspace can be created empty - i.e. the canvas is blank and each new component is added
from scratch - or it can be created so that its initial state contains a number of other
components.
Workspaces can be created using the commands on the File menu, or through shortcuts in the
Start tab.

The Blank Workspace option simply empties the canvas and allows the user to construct all
components manually. The Create and Generate options are ways to create a workspace
containing some components.
Creating a workspace through the Generate options is a simple way to define a translation
because it includes reader, writer and feature type components in the setup process.
The Create Workspace dialog provides options for generating a workspace, but also for
creating one from a template installed either locally or in the FME Store.
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Controlling a Workspace
Workspace parameters are those that relate to a workspace as a whole, and which have an
effect on how the translation is performed. They apply to the current workspace only and may
change between workspaces.
Workspace parameters are shown and set in the Navigator Window.

For ease-of-use, workspace parameters are divided into two sections: basic and advanced.
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Basic Workspace Parameters
There are a number of basic workspace parameters. The most important one is Destination
Redirect.
The Destination Redirect parameter overrides the Writer defined in the workspace. It causes
FME to send the translation output elsewhere and no data is written to the destination datasets.
To write output again the user must remove the redirect by choosing the No Redirect setting.

The destination redirect options are:
l

Redirect to Inspection Application: Output is sent directly to the FME Universal Viewer.

l

Redirect to FFS File: Output is sent to an FFS (FME Feature Store) file.

l

Disable Output: Output is ignored and not used (similar to a NULL format writer).
‘Redirect to Inspection Application’ can also be found on the menu bar, under the
Writers menu.

Advanced Workspace Parameters
The advanced workspace parameters are perhaps not as valuable in everyday use, but have
great importance in specific scenarios. Some particularly important ones are:
Reprojection Engine

Different GIS applications have slightly different algorithms for reprojecting data between
different coordinate systems. To ensure that the data FME writes matches exactly to existing
data, this parameter permits a user to use the reprojection engine from a different application.
A user with ArcGIS installed is choosing to use that package’s engine for reprojecting the
spatial data.
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Password

It‘s often desirable to pass a workspace to an FME user for them to run, but not to edit. A
password-protected workspace cannot be opened for editing in Workbench without the
password.
It can, however, still be run within the FME Universal Translator or from the command line.
Also, developers or consultants may want to pass on a workspace to an FME user without
revealing the contents. Password protecting a workspace causes it to be encoded so that its
contents cannot be read in a standard text editor.
Start-up and Shutdown Scripts

These parameters deliver the ability to run a TCL or Python script before or after an FME
translation.
Script parameters in the workspace settings dialog:

Potential uses of such scripts include:
l

To check a database connection before running the translation

l

To move data prior to or after the translation

l

l

To write the translation results to a custom log or send them as e-mail to an
administrator
To run scripts from other applications; for example Esri ArcObjects Python scripts
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Workspace Properties
Settings that provide information about a workspace, but have no effect on the translationsuch as Workspace Name and Workspace Description - are found in the Workspace
Properties section.

Workspace Properties are basically metadata fields that are useful in investigating
the workspace's history. They appear in the Create Workspace dialog when saved as
a template.
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Readers and Writers

Readers and Writers are the main components that read
and write data in FME.

A Reader is the FME term for the component in a translation that reads a source dataset.
Likewise, a Writer is the component that writes to a destination dataset.
A workspace is often created containing a single Reader and a single Writer, but this does not
mean you are limited to this. Additional Readers and Writers can be added to a workspace at
any time, any number of formats can be used, and there does not need to be an equal number
of Readers and Writers. For example, the Navigator window shows this workspace contains 25
Readers and 32 Writers of all data types and formats!
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Adding a Reader/Writer
Adding a reader or writer to a workspace is a common requirement. There are several
reasons:
l

The Generate Workspace dialog only adds a single Reader and Writer

l

Each Reader and Writer handles only one format of data.

l

Different datasets (of the same format) may require handling with different parameters

Therefore handling multiple formats of data – such as a workspace that reads Smallworld, DXF,
and Geodatabase; and writes to both Oracle and a text file – requires multiple readers/writers.
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Additional readers are added to a translation using Readers > Add Reader from the
menubar. Similarly, additional writers are added using Writers > Add Writer.

Adding a reader has this effect on the hierarchy diagram:
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Be aware that adding Readers and Writers can also add Feature Types to the workspace too, as
is explained in the next section.
Although the usual workflow is to create a new workspace with the Generate dialog
and then add extra components as necessary, there’s nothing to prevent a user
starting with an empty workspace and simply adding readers and writers one-byone.

Removing a Reader/Writer
Not only can you add a new Reader or Writer, you can remove an existing one; for example
when you have an old Writer whose output you no longer need. Tools exist to remove a reader
or writer from a workspace, both on the menubar and in context menus in the Navigator
window.
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Whenever a reader or writer is removed, then all the related feature types will also
be removed.

Controlling Readers and Writers
Reader and Writer parameters are those that control how data is read and written.
Because these parameters refer to specific components and characteristics of the related
format, no two formats will have the same set of control parameters.
Also, because different actions may be required, even the reader and writer of a single format
will have dissimilar sets of parameters.
For ease-of-use, parameters are divided into two sections: basic and advanced.

Reader Parameters
Reader parameters are shown and set in the Navigator Window. You expose the list of
parameters by clicking on the expand arrow icons to the left of the Reader. In most cases there
are a set of basic parameters, then a set of advanced parameters that can be expanded
separately.
To edit a parameter, double-click it. A dialog opens up where the parameter’s value may be
set.

Doctor Workbench says…
‘Some Reader (and Writer) parameters are ONLY accessible through
the Parameters button when you initially create a workspace or add the
Reader/Writer to an existing workspace. That’s because they affect
how the schema is read and therefore how the workspace is constructed.
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It’s like preparing a patient for surgery. Once the workspace (patient) is created
(prepped) those parameters aren’t available because you’re past the point where they
would have any effect.
Of course, sometimes you get such a parameter wrong, in which case you simply
recreate the workspace. Or find yourself a new patient!

Writer Parameters
Writer parameters are also shown and set in the Navigator Window. Like Readers, their
parameters are exposed by expanding the list and there is usually a set of basic and advanced
parameters.
Again, to edit a parameter, double-click it. A dialog opens up where the parameter’s value may
be set.

Parameter Priority
It’s worth emphasizing that, because Readers and Writers are at a relatively high level in the
translation hierarchy, their parameters apply to everything beneath them; that is, ALL
features.
Database Password is a good example of a Reader/Writer-level parameter.
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A database user password is something that applies to ALL tables being read.
There isn’t a different password per table! Therefore it is a Reader/Writer level parameter.

Dataset Parameters
As you may have noticed, among the different parameters for each Reader and Writer are ones
to define which dataset it is reading or writing. Therefore, to select a dataset , these are the
parameters you use. The dataset being read or written is NOT defined by a canvas object.
As usual, double-clicking the parameter opens a dialog for it to be changed. You can change the
dataset being read by selecting any other dataset - of the same format - within that dialog.

When dealing with files (as opposed to databases) FME recognizes two different types of
dataset: File-based and Folder-based.
File-Based Datasets
The key characteristic of a file-based dataset is that all layers (feature types ) are stored within
a single file. Basically a format in this classification will have a way to assign data to different
layers within a single file. An AutoCAD DWG file is a good example of this: each DWG file is a
separate dataset, and each DWG file has its own set of layers.
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In this instance the dataset parameter is simply a pointer to the location of the file(s). This is
true whether it is the Reader or the Writer parameter.

Notice here the source dataset is a single .DWG AutoCAD file.
Folder-Based Datasets
In this class of format, layers are stored as separate files. In other words, a format of this type
DOES NOT have a way to assign data to different layers within a single file; therefore each
‘layer’ is a separate file. An Esri Shape dataset is a good example of this: a single Shape file
cannot store different layers (for example, roads and railway). To create that structure you
would have two Shape files: roads.shp and railway.shp
A text file holding attribute data - whether comma-separated (CSV) or column-aligned (CAT) is also of this type, because you can't create separate tables in a text file. You can in an Excel
spreadsheet, so that would be a File-Based dataset.
Writing a folder-based dataset is easy to set up. The dataset parameter is simply a pointer to
the location of the folder to write to. This is logical: select a folder to define the folder-based
dataset.

Reading is not quite as logical. Rather than select the folder and prompt which feature types
(files) to read, the user is prompted to select the files (feature types) directly.
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In this way, the dataset and feature type selection can be made in a single step. It’s more
efficient, just a little less logical.
Both File or Folder dataset parameters can be pointers to a Zip file. For reading you
simply select the zip file in the source parameter. FME will extract the data when it is
being read. For writing you simply define a zip file and FME will create it when the
data is being written.
Similarly, a File or Folder dataset can be read directly from a URL. Simply enter the
URL into the source parameter. For Folder datasets the URL must point to a zip file
containing all of the relevant files.
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Readers and Writers
Exercise 4a Readers and Writers
Scenario

FME User

Data

Property Parcels (PostGIS) Public Art (Excel) City Properties
(Esri Shape)

Overall Goal

Create list of public art on city property

Demonstrates

Managing and controlling Readers and Writers

Starting Workspace

None

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise4aComplete.fmw

In this exercise you are an FME user at the City of Interopolis. The city is planning its
maintenance budget for the year and wishes to know how many pieces of public art are erected
on city-owned property.
So, your task is to use the data available to identify city properties and find out what pieces of
artwork are located on them.
1) Inspect Data
Start the FME Data Inspector and open the three datasets we will be using:
Reader Format:
Reader Dataset:
Parameters

PostGIS
fmedata
In a web browser (Chrome, etc), go to http://fme.ly/database, and use
the Parameters for "PostGIS on Amazon RDS," and in Table List, choose
ParcelPolygons

Reader
Reader
Reader
Reader

Format:
Dataset:
Format:
Dataset:

Microsoft Excel
C:\FMEData2014\Resources\LI\PublicArt.xlsx
Esri Shape
C:\FMEData2014\Data\Parcels\CityProperties\CityProperties.shp

If you haven't realized it yet, this is going to be a tough assignment. The city owned properties
are point features, not polygons, so we are going to have to use the parcel data to discover the
actual area of each property. Then we will have to overlay the public art features, which at the
moment are in a non-spatial format of data.
2) Start Workbench
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Start Workbench and begin with an empty workspace. Because there are several formats of
source data it's going to be easier to add them individually, rather than generate a workspace.
Choose Readers > Add Reader from the menubar. When prompted enter the format and
dataset of the city properties (Shape) dataset we are using. The dialog should be very similar
to the one in the Data Inspector.

Click OK to close the dialog and add the Reader to the workspace.
3) Add Reader
Now we need to add the property polygons (PostGIS) dataset to the workspace. Use Readers
> Add Reader as in the previous step.
The workspace will now look like this:

4) Add PointOnAreaOverlayer
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Add a PointOnAreaOverlayer transformer. This will tag the property polygons that belong to the
city by carrying out an overlay with the City-Owned dataset.
Connect the CityProperties feature type to the Point input port. Connect the ParcelPolygons.

Again, you can check the parameters, but none should need changing. Note that the number of
overlaps is denoted by an output attribute called _overlaps.
5) Add Tester
Add a Tester transformer. It should be connected to the PointOnAreaOverlayer:Area output
port. We'll use this to check the value of _overlaps. If the value is greater than 1 then we know
this is a city-owned property.
Open the parameters dialog and set up a test for where _overlaps >= 1

Click OK to close the dialog. You can now add some Inspector transformers to the Tester output
and run the workspace to ensure that the results are correct so far.
6) Add Reader
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Now we must add a Reader to read the public art data. Choose Readers > Add Reader from
the menubar. Enter the following info but don't click OK yet:
Reader Format:
Reader Dataset:

Microsoft Excel
C:\FMEData2014\Resources\LI\PublicArt.xlsx

Click the Parameters button. Notice that there are a number of options to preview the data for
each sheet. At the foot of the dialog is the attribute schema. Notice how there are attributes for
Longitude and Latitude. We can change the settings here to have the Reader automatically
convert these to proper spatial features.
Under the Type field for Longitude, click the drop-down arrow and select "x_coordinate". Under
Latitude select "y_coordinate."
Click OK and OK again to close the dialogs and add the Reader to the workspace.
7) Add Reprojector
One issue to still overcome is that the data from the Excel Reader will be in Latitude/Longitude
(because that's what the coordinates were saved as) whereas the other datasets are UTM8310. We'll solve this by reprojecting the data.
Add a Reprojector transformer connected to all of the Excel feature types. Open the
parameters dialog and set it to convert from LL83 to UTM83-10:

8) Add PointOnAreaOverlayer
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Now we just need to determine which of the public art features fall inside one of the city
properties. We can do this with another PointOnAreaOverlayer transformer. Add one of these
and connect the art features to the Points input port and the Tester:Passed features to the Area
port:

9) Add Tester
A final Tester will help us filter the art features we need. Add a Tester connected to this new
PointOnAreaOverlayer Point output port. Again set it up to test where _overlaps is >= 1

10) Run Workspace
Add an Inspector transformer to the Tester:Passed port. Save and run the workspace.
The output from this will be all public art installations that reside on city property.
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ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

Congratulations! You have now:
l

Added Readers to a workspace

l

Checked the Reader parameters
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Feature Types

Feature Types are objects on the Workbench canvas that define the layers being read from, or
written to, a dataset.
If you want to read data from a particular layer, in a particular dataset, then it's not enough to
just select that dataset; you also have to ensure that the layer is defined as a feature type in
the canvas.
In most cases this is not a problem. When you generate a workspace or add a new Reader, the
dataset(s) you choose are scanned and all of the layers within get matching feature type
objects in the workspace.
However, in some cases you need to manage the feature types separately. Perhaps you no
longer wish to read a particular layer (in which case the feature type should be deleted) or
perhaps the dataset has acquired a new layer and this needs to be defined in the workspace (in
which case you will need to add a new feature type).

Adding Feature Types
In general, manually adding a feature type is only permitted on the writer side of a translation.
That’s because the writer side is “What We Want” and is therefore open to manual editing.
Adding a feature type to a Reader is something we'll deal with in an upcoming section.
Adding a Writer feature type manually has this effect on the hierarchy diagram. Your output
was designed to have only a single layer; now it will have two.
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Adding Feature Types to a Writer
Feature Types can be added manually to a writer using Writers > Add Feature Type on the
menubar.

At least one writer must exist in the translation hierarchy; else this option will be
greyed out.
Choosing to add a feature type adds one to the translation, and then causes the Feature Type
Properties dialog to appear in order to edit the feature type properties.
The General tab can be used to define the new feature type’s name.
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The User Attributes tab can be used to define the new feature type’s attribute schema.

Additionally, when adding a Writer FME will offer a chance to manually add a new feature type.

Responding Yes to this question opens up the same dialog for manually defining a new feature
type. However, only one feature type can be added at this time. Additional ones must be added
manually.
Responding No is the correct response when feature types are to be copied from a reader (see
below) or imported from a different dataset (see next section).
Copying Feature Types to a Writer
In the scenario where I have manually added a Reader with its feature types, and wish to
create the same structure on the Writer, the simplest thing to do is copy the feature types. This
is simply done by selecting the source feature types, right-clicking them, and using the option
Duplicate (on Writer).
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The command causes duplicates of the Reader feature types to be added to the writer, and
source/destination feature types to be automatically connected.
Again, at least one writer must exist in the translation hierarchy; else this option will be greyed
out.
In the hierarchy diagram, copying feature types looks like this. The user has a Reader and
Writer. The copy function makes a copy of the source feature types on the Writer. Now when I
run the translation I will get an exact copy of the input:
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Removing Feature Types
The remove feature types tool simply removes one or more feature types from the translation.
For example, if there is a source dataset layer that I wish to no longer read, then I would
delete the matching feature type from the workspace. Similarly, if there is a destination layer
that I no longer wish to write, then I would delete its matching feature type from the
workspace.
There is a menubar option for this tool, but the easier method is to select the feature type(s) in
the canvas and simply press the delete key on the keyboard.
Whenever all feature types are deleted from a reader or writer then FME will prompt the user
to decide whether to remove the reader/writer as well.
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This makes sense because if there are no layers you wish to keep, why would you still wish to
read that dataset? Similarly if there are no layers left to writer, there's no point in having a
Writer component to the workspace.
If you answer No, then the feature types are all removed, but the reader or writer is left in the
translation. We call this a dangling” reader/writer, because it has no children in the hierarchy.
A dangling reader/writer isn’t a problem provided it’s only a temporary situation; i.e.
the user intends to now import or add new feature types.
The workspace should not be run in this condition!
Performance suffers because all the source data is still being read, yet discarded
immediately. Worse, you might be reading the data, and transforming it, then drop it
because no writer feature types are defined!
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Importing Feature Types
To understand importing feature types, it’s important to recognize that “schema” is a separate
entity, capable of being used and copied independently of any actions on the data itself.
What the import tool does is essentially take a dataset’s schema, and add it to a workspace.
For example, a user has a workspace reading from a spatial database.
It only needs to read from a single table (roads), so there is a single Reader representing the
database, and a single Feature Type representing the table.
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However, at some future point the user decides the workspace also needs to read from a
second table (‘rail’).
The simplest solution is to use the command Readers > Import Feature Types…

The import tool will take the schema definition of the database table ‘rail’ and add it to the
workspace.
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This is particularly important for a reader, because there is no “Add Feature Type” tool for a
reader; the reason being that a source schema represents “What We Have” and adding userdefined definitions doesn’t reflect that reality. However, the functionality is still valid for a
Writer. For example, a new table called "railway" has been added to a database and the
workspace needs updating to write to it. Rather than add a separate, new Writer, the best
solution is just to import the "railway" table as a new feature type for an existing writer.

Importing Feature Types from a Different Dataset
Interestingly, the import tool can import schemas from a dataset without that dataset being
part of the actual translation. Even a different format is no impediment to using a schema this
way.
For example, a user may wish to store his database table definitions in XML, importing feature
types from the XML schema for use in writing to his database format. A Spatial Data
Infrastructure (SDI) with a rigidly defined schema, but open format specification, might be one
use of this scenario.
For a Writer, it’s always preferable to import feature types, or copy them from an
existing reader, rather than manually add them. That’s because a manual process is
slower and more prone to user error; especially when case sensitivity is an issue.

Feature Type Parameters
Just like Readers and Writer, Feature Types have their own set of parameters that control how
that feature type (layer/table) is being read or written. The important thing is that these
parameters only apply to a single feature type, whereas a Reader/Writer parameter would
apply to all feature types.
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For example, when writing a database the decision about whether or not to apply an index is
made on a table-by-table basis. Not all tables may require an index and there can be a
different index per table. Therefore this is a feature type parameter.
Conversely, there is no password parameter at the feature type level because it applies to the
entire database, not the individual tables.
So these parameters provide a degree of individual control over reading and writing different
layers or tables.

Reader Feature Type Parameters
Reader feature type parameters apply to reading of specific layers/tables.
A general rule is that database formats have reader feature type parameters, but few filebased formats do.
Feature Type Parameters can also be accessed through the Feature Type Properties dialog.
Notice the tab named FormatParameters.
Not all feature types have parameters, so this tab is not always present.
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Writer Feature Type Parameters
Writer feature type parameters apply to writing of specific layers/tables.
Again, most database formats have writer feature type parameters, but a high proportion of
file-based formats also have these.

Create Spatial Index is a good example of a feature type parameter.
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Feature Type parameters are also found in the Navigator window, under each Reader/Writer,
like so:
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Feature Types
Exercise 4b Feature Types
Scenario

FME User

Data

Property Parcels (PostGIS) Public Art (Excel) City Properties
(Esri Shape) Postcodes (Esri Shape)

Overall Goal

Create list of public art on city property

Demonstrates

Managing and controlling Feature Types

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise4b-Begin.fmw

Finished Workspace C:\FMEData2014\Workspaces\DesktopBasic\Exercise4b-Complete.fmw
This example continues where the previous one left off. In that example you created a
workspace to determine what pieces of public artwork are located on city property.
Now the data must be written out so that it can be used by the finance team. However, before
that, they have asked that we also divide the data up into separate postcodes.
1) Inspect Data
Start the FME Data Inspector and open the datasets:
Reader Format:
Reader Dataset:

Esri Shape
C:\FMEData2014\Data\Addresses\ForwardSortationAreas.shp

This dataset contains a set of polygons marking the postcode boundaries for the city.
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ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

2) Update Dataset Parameter
Start Workbench and open the workspace from the previous example (if it is not already open).
To get this data into the workspace we could simply add a new Reader. However, since we
already have a Reader to handle Shape data, we can use that and simply import the feature
type definition.
So, firstly locate the source dataset parameter for the Shape Reader:
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Double-click the parameter to edit it. If the new postcode Shape file was in the same folder as
the CityProperties Shape file, we could simply select both of them with the regular browser.
However, since they are not, we must do this a little differently.
Click the drop-down arrow and select Open Advanced Browser.
In the advanced browser, click Add Files, browse to the postal code data
(ForwardSortationAreas.shp) and select it:

Click OK and OK again to close these dialogs.
3) Import Feature Type
Now both Shape files will be read when the workspace is run. However, the postcode data will
be discarded because there is no matching feature type.
So, select Readers > Import Feature Type from the menubar.
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When prompted, select the Shape Reader to import the feature type to. Then, in the next
dialog, set the format and dataset parameters, the same way as they usually are.
Now click OK. When prompted to select the types to import, you can click OK again.
CityProperties won't be added again because FME recognizes it exists already. However, a
feature type for ForwardSortationAreas will be created:

4) Add PointOnAreaOverlayer
Now add a further PointOnAreaOverlayer transformer to copy the postcode info onto matching
art features. The ForwardSortationAreas will be the Areas, the output from the final Tester will
be the Points:
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If you add an Inspector and run the translation now, you'll find that there is a postcode
attribute added to the public art features.
5) Add Writer
The finance team (who requested this data) would like it as a MapInfo TAB file. So add a Writer
with the following parameters:
Writer Format:
Writer Dataset:

MapInfo TAB (MITAB)
C:\FMEData2014\Output\Training\

When prompted, do NOT add a feature type manually. Although we could do it this way, it's
easier to copy an existing schema, if one exists.
6) Add Feature Type
Right-click on PublicArt and choose the option to Duplicate (On Writer). A new Writer feature
type will be added that is a copy of the Reader equivalent.
The new feature type will be automatically connected. Here, we don't wish that to happen, so
delete that connection and instead connect it to the final transformer output:
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7) Edit Schema
The schema we created is not exactly what we want, so it should be edited.
l

name - char(46)

l

title - string(32)

l

PostCode - char(3)

l

Address - char(30)

So open the properties dialog for the new Feature Type. Click on the User Attributes tab and
edit the schema to what is required, but don't click OK yet.
8) Set "Fanout"
Click on the General tab. Check the box marked Fanout by Attribute and select the attribute
CFSAUID:
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A fanout is an advanced function that will be useful here. By checking this box, and selecting
the postcode attribute, we will get a separate table of features for each different postcode.
Click OK to close the dialog.
9) Map Schema
The final step is to map the schema correctly, as nothing is connecting up as yet. Draw
connections between:
l

CSFAUID - PostCode
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10) Run Workspace
Save and run the workspace. Inspect the output in the FME Data Inspector. You should find
there are 38 features on a number of layers, each defined by a postal code:
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Congratulations! You have now:
l

Imported a Feature Type Definition

l

Added a Writer

l

Added a Writer Feature Type

l

Modified Feature Type parameters

l

Used a fanout
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Managing Reader Datasets

It’s very simple to use a dataset parameter to change
the data being read; but care must be taken to avoid
certain pitfalls.

Non-Matching Data
When using dataset parameters it's possible to change a Reader to read a different source
dataset (or datasets) than those selected when the workspace was created initially.
This is useful because it allows a workspace author to create a prototype workspace, test it on
a single source dataset, and then adjust the workspace to read all source data.
However, it’s important to remember that the original dataset establishes the basis for the
reader schema definition. Problems arise if subsequent datasets do not conform to this original
schema.
Datasets with Different Attributes
As already noted, a schema definition includes user attributes. If a reader is defined with one
set of attributes, then made to read datasets with different attributes, there is an obvious
conflict.
The problem is that user attributes are fixed in the reader schema, which is why they are
grayed-out in the properties dialog.
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In fact the attributes are read and attached to incoming features, but since they won’t appear
on the writer schema, they will not get written to any output dataset (that requires a dynamic
writer).
Furthermore, since the attributes don’t appear in the workspace itself, there is no way for the
workspace author to manipulate them with transformers.
Datasets with Different Feature Types
Similarly, a schema includes the definition of a source dataset’s feature types.
If the reader is defined with one set of feature types, then switched to read datasets with
different feature types, then that is another source of conflict.

Again, the problem lies in having a fixed source schema, where feature types are not
automatically updated when new data is read.
In this scenario the data is automatically discarded; i.e. reader feature types defined in the
workspace act as a type of filter through which incoming data must pass.
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Unexpected Input
Exercise 4c Unexpected Input
Scenario

FME User

Data

Public Art (MapInfo TAB)

Overall Goal

Read Public Art from previous exercise

Demonstrates

Unexpected Input

Starting Workspace None
Finished
Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise4c-Complete.fmw

This example merely reads a file of contour data, but demonstrates a potential problem when
changing the source dataset parameter.
1) Inspect Data
Start the FME Data Inspector and open the datasets:
Reader Format:
Reader Dataset:

MapInfo TAB (MITAB)
C:\FMEData2014\Output\Training\*.tab

In other words, select all of the MapInfo files in that folder.

ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

2) Create Workspace
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Start FME Workbench and begin with an empty workspace. Select Readers > Add Reader
from the menubar.
When prompted enter the format and dataset for ONE of the contour files, for example V5T.tab.

Add an Inspector and run the workspace to ensure it works as expected.
3) Change Dataset
Now we'll assume that someone else has asked you to translate a different file, for example
V5Y.tab.
So, locate the source dataset parameter in the Navigator window:

Double-click the parameter and a Source Shape File dialog opens up. Use the browse button to
select V5Y.tab.
4) Run Workspace
Run the workspace. You will get a dialog pop up reporting that there was "Unexpected Input."
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What this means is that you've tried to read a layer of data that is not defined in the
workspace.

Congratulations! You have now:
l

l

Modified the Reader dataset parameter
Discovered a potential problem of modifying the Reader dataset
parameter!

This example illustrates how a workspace created to process one dataset may not be suitable
for all datasets of the same format, even when that dataset is a simple update to the original.

The Unexpected Input Remover
Every time FME reads a dataset, it checks the feature types inside that dataset to ensure that
they are all defined within the workspace schema. If there are feature types that exist in the
dataset, but do not exist in the workspace, then features are classed as unknown and filtered
out by a function called the Unexpected Input Remover.
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The actions of the Unexpected Input Remover are reported in the Log file and through a dialog
that opens at the end of a translation.
Recheck the Unexpected Input dialog from the previous example. FME dropped a number of
features from the translation because their feature type was unknown in the workspace.
Notice how each feature type mentioned is listed along with a count of the affected features.

Also notice the checkbox that allows this report to be turned off in future translations.
It’s important to understand that the feature types in a dataset do not necessarily have to be
the same feature types as defined in the workspace.
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For example, a user may purposely leave a feature type out of a workspace if that layer of data
is not required in the translation.
In that scenario, the Unexpected Input dialog may still pop up, but can be safely ignored as the
user deliberately requires this behaviour.
Therefore this dialog is considered a reminder rather than an error, and is not always an
indication something has gone wrong.
Unexpected Input and Dataset Type
Remember, in general terms, there are two different types of dataset: file-based and folderbased. Just as they are read slightly differently, the Unexpected Input Remover operates on
them in the same way.
File-Based

File-based datasets are the easiest to understand. If there is a layer in the file that is not
represented on the canvas then FME treats the data as "unexpected" and the Unexpected
Input Remover will drop it from the translation.
For example, if I set up my translation to read the layers Roads, Rail, and Rivers, then a new
layer of data is added to the source dataset (or I switch the dataset to a different one) then new
layers - like Vegetation, Buildings, etc - will be dropped.
Folder-Based

Folder-based datasets are when the layers are stored as separate files in a folder; for example
a Shape dataset with multiple shp files.
In this case, if I have set up a translation to read one Shape file, then change it to read a
different one, then the data is unexpected - because it is a different layer, one not represented
by a feature type. This is the exact scenario in the previous example.
In fact, this most often becomes a problem when a set of tiled datasets are being read, as each
tile is a separate file (feature type) and needs a separate definition if it is to be allowed into the
translation.
Unexpected Input is Not an Error!
It’s important to understand that the feature types in a dataset do not necessarily have to be
the same feature types as defined in the workspace.
For example, a user may purposely leave a feature type out of a workspace if that layer of data
is not required in the translation.
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In that scenario, the Unexpected Input dialog may still pop up, but can be safely ignored as the
user deliberately requires this behaviour.
Therefore this dialog is considered a reminder rather than an error, and is not always an
indication something has gone wrong.

Dealing with Source Feature Types
Assuming the Unexpected Input dialog does indicate a problem, there are two different
methods within Workbench by which to resolve the issue:
l

Add the missing feature types
In other words, feature types are missing; so let’s add them.
The Import Feature Type tool can be used to do this.

l

Relax the filtering process
In other words, allow unexpected feature types to pass through an existing one.
Merge parameters can be used to deliberately permit undefined feature types to pass.

Import Feature Type
The Import Feature Type tool will take the schema definition of a selected dataset and add it to
the workspace. By adding in the missing feature types to the schema, features of that type will
be allowed to pass into the workspace.
Once in the workspace the data will now be read and accepted as having a matching feature
type.
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This is exactly the scenario that took place with exercise 4c. If we hadn't imported the feature
type in Step 3 the result would have been unexpected input.

Professor Spatial says…
‘It really helps to think of a schema as an object in its own right,
related to, but not restricted to, a particular format. Therefore it’s
possible to import a schema from one dataset, to use in a reader or
writer of an entirely different format.

Of course, reading is only one part of a translation. To actually write the data also
requires that the same import function takes place on the writer. But notice that
when you import a Reader feature type, there is also a setting to "Add to Writers".
This method is the simplest way to import the same set of feature types to both the
reader and the writer.
However, sometimes you won’t want to import the same on each side of the
translation.
To handle that scenario, there are two other ways to import writer feature types.
1. Use Writers > Import Feature Types
on the menubar. This has the same effect
on the writer as importing types on a
reader.
2. Right-click a reader feature type on the
canvas, and choose the option “Duplicate
(on Writer). This will copy a feature type from reader to writer, and
automatically connect it.
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Q) Professor Spatial, I have two completely different datasets (City Parks and Polluted Sites)
unrelated except for being the same format.
If I want to read them into the same workspace, does each need a separate reader?

A) They don’t necessarily need separate readers, because you can add all the feature types
from the two datasets to the same reader.
However, look at the Reader Parameters for that format of data.
If there is a reader parameter that needs to be different for each dataset, then you will need to
create two readers, one for each dataset, and change the parameter on each as necessary.

Merge Parameters
Rather than adding in missing feature types to a workspace, the second option is to relax the
restrictions on the feature type filtering process, purposely letting undefined feature types to
pass.
Merge Parameters are available in each reader feature type for this purpose.
The functionality is described as a merge, because features with an unknown feature type are
literally merged into the input from an existing feature type.
The first action is to select a feature type through which to merge the data and open its Feature
Type Properties dialog.
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Once the Merge Feature Type option is checked a Merge Filter can be set. This is used to define
exactly what incoming feature types are allowed to merge.
The filter type can be a wildcard or a regular expression.
In this example an asterisk (*) means FME should accept any unknown data into the workspace
through this feature type.
In the workspace itself, the title of the feature type object is updated to reflect the filter being
applied.

A Feature Type merge unlocks a workspace and allows to pass any feature types that are not
currently defined.
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Fixing Unexpected Input
Exercise 4d Fixing Unexpected Input
Scenario

FME User

Data

Public Art (MapInfo TAB)

Overall Goal

Read Public Art data

Demonstrates

Unexpected Input

Starting Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise4d-Begin.fmw

Finished Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise4dComplete.fmw

This example fixes, in a simple way, the problem of reading multiple files in a workspace.
1) Start Workbench
Start Workbench and open the workspace from the previous example (if it is not already open).
Remember, when this is run the Unexpected Input Remover pops up. That's because you are
trying to read a layer/file called V5Y, when no V5Y feature type exists in the workspace.
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We could resolve this by using the Import Feature Type tool, but to handle all of the files in this
way would result in a translation that looked like this:

So, we'll fix this translation a better way, by unlocking the single feature type we have to let
any of these files past.
2) Set Merge Filter
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Open the properties dialog for the Feature Type. In the middle of the dialog select the option
Merge Feature Type:

In the Merge Filter field we can define which files we will allow to pass. Because there isn't
really a common theme to the file names (or not one that we can easily define without using a
regular expression) simply enter an asterisk in that field:

This means we'll allow any and all files to pass. In fact, when you press OK, the feature type
object is updated to reflect that fact:

3) Run Workspace
Now when the workspace is run the chosen data will be allowed to pass. In fact, you should be
able to select any - or several - of the contour Shape files and they will all pass.

Congratulations! You have now:
l

Used a Merge Filter to avoid Unexpected Input
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Doctor Workbench says…
‘You can probably see one drawback of this method: all of the
features are merged into a single bloodstream – sorry, data stream
– in the workspace. If I want unique output feature types I must
separate the data again.
In this case it’s not too much of a problem, as the data is all the same type just tiled
separately. But you may want to reflect on when the Import Feature Type tool is a
better option.

Chapter 4 - Readers and Writers

256

FME Desktop Location Intelligence Manual

Miss Vector says…
“Attention, please! It’s time for a quiz to see what you’ve learned so
far.
Turn to a fellow student and answer these questions between you.”

What problem does the Import Feature Types and the Merge Filters options solve?
1) Reading datasets with different attributes
2) Reading datasets with different Feature Types
3) Reading datasets with different formats
4) Reading datasets with different geometry types

What does the Import Feature Types option do?
1) Adds missing Feature Types
2) Lets any Feature Type pass
3) Turns off the Unexpected Input Remover
4) Updates the attributes on an existing Feature Type

What does merging filters do?
1) Adds missing Feature Types
2) Lets any Feature Type pass
3) Turns off the Unexpected Input Remover
4) Updates the attributes on an existing Feature Type

What do you think are the relative benefits to the Import Feature Types and Merge Filters
functionality? That is, what advantages and disadvantages does each have?

Discuss this issue with a fellow student. Examine the workspace for example 21 to see if there is
anything you can do to resolve any merge filter disadvantages.
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Module Review

This session was designed to increase your knowledge of
how FME handles different spatial data formats.

What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
l

l

l

l

l

A translation is made up of a Workspace, Readers and Writers, and Feature Types.
Tools exist to manage all of these components.
Readers and Writers are defined by entries in the Navigator window, Feature Types by
objects in the workspace canvas.
Translations are controlled by Reader and Writer Parameters and Feature Type
Parameters
Datasets are selected by Reader and Writer parameters in the Navigator window, not in
the canvas.
The Unexpected Input Remover filters incoming data if it doesn’t match a known
feature type defined in the workspace.

FME Skills
l

The ability to set up and manage the components of a translation.

l

The ability to control a translation with read and write parameters.

l

The ability to handle source datasets regardless of feature type or attributes.
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Chapter 5 - Practical Transformer Use
Even experienced FME users find the full list of
transformers a daunting sight. In this section you’ll learn
to stop worrying and love the transformer gallery.

With over four hundred (400) transformers FME possesses a lot of functionality; probably a lot
more than a new user realizes, and much of which would be very useful to them. This section
helps find the transformer you need, even if you didn’t realize you needed it.

Transformer Gallery
The transformer gallery is the obvious place to start looking for transformers. There are a
number of ways in which transformers here can be located.

Transformer Categories
Transformer categories are a good starting point from which to explore the transformer list.
Transformers are grouped in categories to help find a transformer relevant to the problem at
hand.
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Important categories include:
l

Calculators: Calculate a value and supply it as a new attribute.

l

Database: Interact with external databases.

l

Filters: Split and re-route data

l

Geometric Operators: Process feature geometry.

l

Infrastructure: Structural transformation and scripting with Tcl/Python

l

Lists: Work with list attributes.

l

Rasters: Work with raster datasets.

l

Strings: Create, modify and delete string (character) attributes.

l

Stylers: Prepare features for output to particular formats.

l

Surfaces: Work with surfaces; for example, create contours.

l

Web Services: Communicate with web services using HTTP.

l

Workflow: Run workspaces either locally or on an FME Server.

l

XML: Transformers that deal with bringing XML data into FME.

Simply click on the expand button to show all transformers within a particular category.

Transformer Help
One new calculator transformer for FME 2014 is the NullAttributeMapper.

The Transformer Gallery is directly linked to the Help window is: a transformer selected in the
gallery triggers help contents to display in the Help window.
When a search returns multiple transformers then the Transformer Description is shown for the
first transformer in the list.

Transformer Searching
There are search functions in both the transformer gallery and Quick Add dialog.
To perform a search in the transformer gallery, simply enter the search terms and either press
the <enter> key or click the search icon (the binoculars icon).
The transformer gallery search searches in both name and description. Therefore a search
term may be the exact name of a transformer, or it may be a general keyword referring to
functionality in general:
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Search terms can either be full or partial words, and may consist of a number of keywords,
including quote marks to enclose a single search reference.

Quick Add search-terms can also be full or partial words:

By default, Quick Add does not look in transformer descriptions, so the search term must be
the actual name of a transformer.
However, Quick Add will search in the transformer descriptions if you press the <TAB> key.
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Quick Add results include transformers found in the FME Store.
The FME Store is a facility for sharing (and selling) FME functionality such as custom
transformers and formats.
Such transformers are flagged in the search tools with a small, downwards-pointing arrow
icon.
The full set of available transformers can be browsed by visiting fmestore.safe.com
CamelCase
Quick Add also allows the use of CamelCase initials as a shortcut. CamelCase is where a single
keyword is made up of several conjoined words, each of which retains an upper case initial; for
example AttributeFileWriter (AFW) or ShortestPathFinder (SPF).
Quick Add will find all transformers whose upper case characters match the search term
provided.
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For example, Quick Add will return the ShortestPathFinder when the search term is the initials
“spf”:
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Most Valuable Transformers

If you have a thorough understanding of the most
common transformers then you have a good chance of
being a very efficient user of FME Workbench.

Anyone can be a proficient in FME using only a handful of transformers; if they are the right
ones!

The Top 25
At Safe Software, we find it useful to keep a list of the most-used transformers. It tells us
where to direct our development efforts in making improvements. And no doubt it will give
users a head-start on knowing which of the (400+) FME transformers they’re most likely to
need in their work.
The following table provides the list of the most commonly used 25 transformers in FME 2014,
calculated from user feedback. The Tester transformer is consistently number one in the list
every year, highlighting its importance.
Rank
1
2
3
4
5
6
7
8
9
10
11
12
13

Transformer
Tester
AttributeCreator
Inspector
FeatureMerger
Clipper
AttributeRenamer
AttributeFilter
Creator
TestFilter
Reprojector
GeometryFilter
AttributeRemover
AttributeKeeper

Rank
14
15
16
17
18
19
20
21
22
23
24
25

Transformer
Bufferer
Counter
AttributeExposer
Aggregator
StringReplacer
Logger
Dissolver
GeometryCoercer
StringConcatenator
Joiner
VertexCreator
Deaggregator

Besides the obvious transformers for transforming geometry (Clipper, Bufferer, Dissolver) and
the obvious transformers for transforming attribute values (StringReplacer,
StringConcatenator, Counter) there are some other distinct groups of transformers.
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Managing Attributes
These transformers are for managing attributes - rather than changing their values. They can
be used to create new attributes, rename them, set values, and delete them. Commonly these
transformers are used for Schema Mapping purposes.
Filtering
Filtering is the technique of subdividing data as it flows through a workspace. Commonly the
filter is a conditional filter; where the decision about which features are output to which
connection is decided by some form of test or condition
Data Joins
Joins are the opposite action to filtering; they are when separate streams of data are combined
as they flow through a workspace. Like filtering, there may be a test or condition that
determines how the data is matched up to be joined.
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Managing Attributes

The top 25 transformer list showed transformers for
managing attributes are very popular.

A high proportion of the top 25 transformers are support transformers for managing attributes.
These create new attributes, rename them, set values, and delete them.
A key use for these transformers is to rename attributes for the purpose of schema mapping.

Attribute Managing Transformers
The key transformers for managing attributes are these:
l

AttributeCreator

l

AttributeRenamer (and BulkAttributeRenamer)

l

AttributeCopier

l

AttributeRemover (and BulkAttributeRemover)

l

AttributeKeeper

l

AttributeExposer

Many of these transformers can carry out similar operations. In fact, with the AttributeCreator
and AttributeRenamer transformers having the widest range of functionality, some users may
use these two attribute-related transformers to the exclusion of all others.

Lists
A List in FME is a mechanism that allows multiple values per attribute.
For example, the attribute myAttribute can only contain a single value.
However, the list attribute myList{}.myAttribute can contain multiple values as:
l

myList{0}.myAttribute

l

myList{1}.myAttribute

l

myList{2}.myAttribute

l

etc.
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There are various transformers designed to operate specifically on lists, and list functionality is
built into other transformers (such as the AttributeCreator) too.

AttributeCreator
With functionality for string concatenation and expression evaluation the AttributeCreator is the
all-singing, all-dancing transformer of choice for handling attributes in workspaces.
There is an ever-lengthening list of capabilities for this transformer, but the main ones are:
l

Manually Create an Attribute

l

Set an Attribute Value

l

Copy an Attribute

Manually Create an Attribute
The fundamental purpose of this transformer is to manually enter an attribute name and value
for it. It is essentially an author-defined constant since every feature gets the same value.
Set an Attribute Value
Because the Attribute Name field allows an attribute to be selected from a list, it can be used to
set the value of an existing attribute, rather than manually entering a new attribute name.
Again, this is an author-defined constant, since every feature gets the same value for that
attribute.
Copy an Attribute (Can replace the AttributeCopier)
Since the Value field allows an attribute to be selected from a list, this transformer can be used
in place of an AttributeCopier, to copy the value from one attribute into another (either a new
attribute, or an existing one).

Here the user is:
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l

Manually creating a new attribute and setting a value for it

l

Setting a value for an existing attribute

l

Copying an existing attribute to a new one

AttributeRenamer
This is a comprehensive transformer that can be used to do many tasks, including:
l

Renaming an existing attribute

l

Renaming an existing attribute and setting a new value for it

l

Manually creating a new Attribute (and setting a value)

l

Deleting an attribute

Rename an Attribute
The fundamental purpose of this transformer is to select an attribute and manually enter a new
name for it. The old attribute is removed and replaced with the newly named one.

Provided the Default Value field is left empty, the new attribute will take the value of the old
one.
This is obviously of most use when wanting to read data that has one schema (set of attribute
names) and write it to a dataset that needs a different schema.
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Rename and Set an Attribute
A field in the parameters dialog allows the user to set a default value. This way an attribute can
be renamed, and a new value defined for it, simultaneously.
Manually Create (and Set) an Attribute
Entering a value into the New Attribute field, without selecting an Old Attribute, means a new
attribute is created; substituting for the AttributeCreator.
Entering a value into the Default Value field when a new attribute is created effectively creates
the attribute and sets a value for it in one operation. Every feature gets the same attribute with
the same value. Again, this can be used as a substitute for the AttributeCreator.

Delete an Attribute
By selecting an Old Attribute, but leaving the New Attribute field empty, the old attribute will be
deleted.
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BulkAttributeRenamer
This transformer carries out the core function of the AttributeRenamer; renaming attributes.
But instead of manually specifying each attribute, this transformer lets the user enter a stringmatching expression in order to define which attributes to rename.
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This transformer is very powerful as it can carry out a number of renaming actions. These are:
l

Add String Prefix

l

Add String Suffix

l

Remove Prefix String

l

Remove Suffix String

l

Regular Expression Replace

l

String Replace

l

Case Change
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The power of the transformer is also in its ability to manipulate multiple attributes at once,
without having to individually select them all.
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It can be particularly useful when the incoming data has a prefix or suffix on the attribute
names that needs to be removed, or (like here) when all the incoming attributes are
mixed/lowercase and need to be UPPER case on the output.

AttributeCopier
The AttributeCopier transformer is similar in structure to the AttributeRenamer – obviously
retaining the old attribute as well as creating the new – but in a much simpler dialog.
The source attribute is simply a pick list, and the target can either be an existing attribute or a
newly defined one.

The dialog also includes a Default Value field so that the newly copied attribute can (optionally)
be given a new value.
Again this is of use when wanting to read data that has one schema (set of attribute names)
and write it to a dataset that needs a different schema.

AttributeRemover
AttributeKeeper
These two transformers carry out the same function, but approach it from opposite directions.
Both remove attributes from features. However the AttributeRemover lets the user specify
which ones are to be removed, whereas the AttributeKeeper lets them specify which ones are
not to be removed; in other words, this transformer lets the user specify which ones to keep.
Basically, use:

Chapter 5 - Practical Transformer Use

273

FME Desktop Location Intelligence Manual

l

l

The AttributeRemover when one or two attributes are to be removed, but the majority of
them kept.
The AttributeKeeper when the majority of attributes are to be removed, and only one or
two of them kept.

Perhaps a more important question is what benefit removing attributes brings.
l

l

l

Removing attributes that aren’t required tidies up a workspace and makes it easier to
understand what is happening.
Removing attributes helps speed up Workbench. Whenever a connection is changed or a
transformer added, Workbench has to check to see how this affects the workspace. The
fewer attributes, the less checking is required; therefore, Workbench performs faster.
Removing attributes also helps speed up the translation. FME caches data to memory and
disk at various stages of a translation. The fewer attributes, the less data needs to be
cached, improving both speed and use of memory resources.

However, attributes don’t need to be removed to avoid writing them to a destination dataset.
If the attribute isn’t defined on the destination schema, then it won’t get written, regardless of
whether the attribute exists or not. Only FME’s internal format (FFS) breaks this rule.

BulkAttributeRemover
This transformer lets the user enter a string-matching expression in order to define which
attributes to remove. As its name implies, it is very similar in operation to the
BulkAttributeRenamer.
It is useful for removing a whole series of similarly named attributes.
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Attribute Management
Exercise 5a Attribute Management
Scenario

Converting an address database to a format suitable for web
streaming/delivery

Data

Addresses (PostGIS)

Overall Goal

Convert PostGIS to GML and map schema

Demonstrates

Attribute Management for Schema Mapping

Start Workspace

None

Finished Workspace C:\FMEData2014\Workspaces\DesktopBasic\Exercise5a-Complete.fmw
The city has an important project. As part of a push for open government, the corporate
address database is to be made available online. However, it is currently held in PostGIS
format and this is not thought suitable to deliver in its raw form. Instead the data will be
translated to a GML/XML format and transformed into a new schema.
1) Inspect Source Data
The first task is to familiarize yourself with the source data. To do this open the following
dataset within the FME Data Inspector.
Reader Format:
Reader Dataset:

PostGIS
fmedata

The table that is to be translated is called "PostalAddresses". The important thing here is not
how the data looks in the graphic display, but more what attributes exist in the Table View
window.

2) Create Workspace
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Now that you are familiar with the data, start FME Workbench and begin with an empty
workspace. Select Readers > Add Reader from the menubar.
Add the Reader with the same values as in the Data Inspector.
Reader Format:
Reader Dataset:

PostGIS
fmedata

3) Add Writer
Now let's add a Writer to write the output data. Select Writers > Add Writer from the
menubar and use the following:
Writer Format:
Writer Dataset:

GML (Geography Markup Language)
C:\FMEData2014\Output\Training\AddressFile.gml

Click OK to add the Writer. However! When prompted do NOT add a new feature type to the
Writer:
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4) Import Feature Types
A new feature of FME 2014 is the ability to write the schema of any required GML application.
To do so we simply import that schema to the workspace. This is useful here because the
schema for the GML data has been specifically designed for this address data.
Select Writers > Import Feature Types from the menubar.
When prompted set the following parameters. The Dataset can be left as it is or emptied (left
blank). It is not the important part:
Reader Format:
Reader Dataset:
Parameters
Application Schema:

GML (Geography Markup Language)

C:\FMEData2014\Resources\AddressSchema.xsd

Click OK to accept the values. You will be prompted to select the feature type (PostalAddress) simply click OK - and then the new feature type will be created to match the chosen
GML application schema.
The workspace will now look like this:
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5) Map Schema
OK, we now have the Reader and Writer in place. Now we can start to map the schema from
Reader to Writer. As you'll have noticed, the two do not currently match up very well.
Firstly, add an AttributeRenamer transformer and connect it between Reader and Writer
feature types, then open the AttributeRenamer parameters and remove the following
attributes:
l

AddressId

l

LastEditor

l

LastUpdate

l

OwnerName1

l

OwnerName2

l

PostalAddressId

l

PostBoxType

l

PostBoxId

l

PostBoxGroup

l

Represent

l

SiteAddressKey

l

Status
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Click OK to close the dialog.
6) Rename PostalCity and PostalProvince
Two source attributes (PostalCity and PostalProvince) can be written to the output as they are,
but do need renaming first.
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Open the parameters dialog. Set up the parameters to rename:
l

PostalCity to City

l

PostalProvince to Province
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7) Add the attribute Provider
Add a 'New Attribute' to the AttributeRenamer called Provider. Provide it with a 'Default Value.'
The value can be your own organization name, or "Safe Software" or "City of Interopolis."
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8) TimeStamper
Add a TimeStamper transformer after the AttributeCreator.

Open the parameters dialog for the TimeStamper.
Set the "Time Stamp Format:" to XML Date.
Set the "Time Stamp Attribute" to UpdateDate.
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Click OK to close the dialog.
Why not run the translation now, with Redirect to Inspection Application turned on,
to see what the result of our efforts so far is?
9) Add AttributeSplitter
Looking at the output schema there are two fields for Number and Street. However, the source
schema condenses that information into one field with <space> characters separating the
fields. Therefore we'll have to split these out.
Insert an AttributeSplitter transformer before the AttributeRenamer. Open the parameters
dialog. Set PostalAddress as the attribute to split and enter a space character into the Delimiter
parameter. Ensure that a list name is set in that particular parameter.
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Click OK to close the dialog.
10) Edit the AttributeRenamer to remove PostalAddress
Now the PostalAddress attribute has been split up into a list of items, we no longer need it. To
clean up the data let's remove that attribute.
Edit the AttributeRenamer transformer and select PostalAddress as the attribute to be
removed.
11) Add the Number attribute to the AttributeRenamer
Now let's handle the Number field in the output.
For the "Old Attribute" field select _list{} (which is the list of separated values created by the
AttributeSplitter). You will be prompted which item in the list is to be used. It will be the first
part - entry number 0 - so simply click OK to accept this.
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Now for the "New Attribute" field select Number from the drop down list

Click OK to close the dialog.
12) Add ListConcatenator
The final step is to recreate the Street attribute, without it being prefixed by the address
number.
Place a ListConcatenator transformer after the AttributeRenamer and open the parameters
dialog. Set the 'List Attribute' to _list{}, and for the 'Separator Character' press the spacebar to
enter a <space> character.
For the Destination Attribute field enter the name Street
In this way we will have concatenated all parts of the street name back together, for example:
"W"+"17th"+"Street" becomes "W 17th Street"
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13) Run Workspace
Save and then run the workspace.
Open the containing folder to check the output has been written. There should be both an output
file and schema document. Inspect the data in the FME Data Inspector. The output (with a
background map turned on) should look like this:

ArcGIS Online Sources: Esri, DeLorme, NAVTEQ, USGS, Intermap, iPC, NRCAN, Esri Japan, META, Esri China (Hong
Kong), Esri (Thailand), TomTom, 2013

Congratulations! You have now:
l

Used various transformers to manage attributes and map a schema
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Conditional Filtering

Transformers that filter don’t transform data content,
yet surveys show that they’re the most commonly used
type of transformer there is!

What is Filtering?
Filtering is the technique of subdividing data as it flows through a workspace. It’s the case
where there are multiple output connections from a transformer, each of which carries data to
be processed in a different way.
A filtering transformer may be part of the Filter category (such as the ChangeDetector
transformer) or the definition can be stretched to include any transformer with multiple output
ports, such as the SurfaceModeller transformer, which has output ports for contours, DEM
points, TIN edges, triangles, and more.
However, Conditional filtering is where the decision about which features are output to which
connection is decided by some form of test or condition. The Tester transformer is the most
obvious example of this. It carries out a test and has different output ports for features that
pass and fail the test.

Transformers that Filter
The transformers in the Filter category are the main group that carry out these tests and
redirect data according to the results.
Although the Tester transformer is the most used of this category, there are many other
transformers such as the GeometryFilter, AttributeFilter, SpatialFilter, and Sampler.
Filter transformers have their own category within the Transformer Gallery.
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The Tester and TestFilter Transformers
The Tester transformer is the key transformer for conditional filtering of data.
Tester

Not only can the Tester (number 1 in the top 25) carry out single tests, it allows the
combination of multiple tests, where a user can combine any number of clauses using an AND
and OR statement.
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This Tester simply filters address features, depending on whether they are part of the V6E
postal code. It also demonstrates the usefulness of annotating a workspace!

This Tester is using the AND pass criteria. Here all clauses must apply for a feature to pass the
test. In this case an address must be in postal code V6E and also be a commerical property.
Non-commercial properties in V6E, or commercial properties in a different postal code, will fail
this test.

Besides the usual operators, there are also some based
on a SQL where clause. These include:
l

In

l

Between

l

Like

l

Matches Regex

l

Contains

l

Begins With

l

Ends With

…plus there are other tests that test for the existence of
attributes and values:
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l

Attribute is Null

l

Attribute is Empty String

l

Attribute is Missing

TestFilter
The TestFilter (#9 in the top 25) is essentially a way to combine multiple Tester transformers
into one.
Because of this, it’s equivalent to a whole string of Testers, and similar to the CASE or SWITCH
command in programming or scripting languages.
The TestFilter has the full set of operands available with the Tester such as equals, greater
than, less than, and so forth. Each condition is tested in turn.
Features that pass are output through the matching output port. Features that fail are sent on
to the next condition in the list. Therefore it’s very important to get the conditions in the correct
order.
TestFilter also lets the output ports be individually named, which is very convenient.
Because the TestFilter can operate as a single Tester transformer would, it’s
possible to replace all instances of the Tester in a workspace with a TestFilter.

In this example the user has used three Tester transformers (and six connections) to filter out
the different parts of this data.
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With the TestFilter, the three Testers are now replaced with one single transformer and there
are only four connections.
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Also notice how the TestFilter output ports have custom naming. This is another advantage to
this transformer.

Other Key Filter Transformers
The Tester and TestFilter are not the only useful filter transformers.
AttributeFilter
The AttributeFilter transformer (#5 in the top 25) directs features on the basis of values in a
chosen attribute.
In this example features are divided into different postal codes depending on the value of a
PostalCode attribute.

Dear Aunt Interop…
If the Tester, TestFilter, and AttributeFilter all filter features on the
basis of an attribute condition, then what’s the difference? When
would I use each?
‘Use the Tester to filter one value of many attributes.
Use the TestFilter to filter many attributes and values using a mathematical clause.
Use the AttributeFilter to filter many values of the same attribute and when the
clause is a simple string comparison.’

If your workspace looks like this then an AttributeFilter transformer might be a better option.
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If the conditions were mathematical (for example, size > 100), then the TestFilter would be the
best choice.
AttributeRangeFilter
The AttributeRangeFilter carries out the same operation as the AttributeFilter, except that it
can handle a range of numeric values instead of just a simple one-to-one match.
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The AttributeRangeFilter parameters dialog has the option to generate ranges automatically
from a set of user-defined extents.
GeometryFilter
The GeometryFilter (#11 in the top 25) directs features on the basis of geometry type; for
example, point, line, area, ellipse.

The GeometryFilter is useful for…
l

l

Filtering out unwanted geometry types; for example removing text features before using
an AreaBuilder transformer
Dividing up geometry types to write to separate destination Feature Types; for example,
when writing to a geometry-restricted format such as Esri Shape
For FME 2014 the GeometryFilter lets you pick which geometry ports to include, whereas before
all geometry output ports were included, to reduce the overall size of the transformer.

ChangeDetector
The ChangeDetector detects changes between two sets of input features and routes data based
on the results of this comparison.
‘UNCHANGED’ features are those present in both the original and revised streams. ‘ADDED’
features only exist in the revised stream and ‘DELETED’ features only exist in the original
stream.
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Exercise 5b Conditional Filtering
Scenario

FME user; City of Interopolis, Planning Department

Data

Addresses (PostGIS), Zoning (MapInfo TAB) Roads (PostGIS)

Overall Goal

To find all residential addresses within 1000 feet of an arterial highway.

Demonstrates

Conditional Filtering

Starting
Workspace

None

Finished
Workspace

C:\FMEData\Workspaces\DesktopManual\Exercise5b-Complete.fmw

Because noise control laws are being amended in the City of Interopolis, residents living in a
single-family residence within 50 metres of a major highway must be contacted to inform them
of these changes.
It is your task to find all affected residential addresses.
1) Start Workbench
Start Workbench and create a new empty workspace.
2) Add Address Reader
Use Readers > Add Reader to add a reader for address data.
Reader Format
Reader Dataset

PostGIS
fmedata

Reader
Parameters
Table List

In a web browser (Chrome, etc), go to http://fme.ly/database, and use
the Parameters for "PostGIS on Amazon RDS".
AddressPoints, Roads

3) Add Zoning Reader
Use Readers > Add Reader to add a reader for zoning data. The zoning data will be used to
determine whether an address is single-family residential or not.
Reader Format
Reader Dataset

MapInfo TAB (MITAB)
C:\FMEData2014\Data\Zoning\Zones.tab
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Don't forget to inspect all of the source data to familiarize yourself with the contents.
4) Edit Roads to only read Arterial roads
Open the Feature Type Properties for Roads, and go to the Format Parameters tab. For the
Where clause, enter the following:
type = 'Arterial'
Run Roads out to an Inspector (again) to see if the Arterial roads are now the only ones being
read.
5) Add Tester Transformer
Add a Tester transformer to the Zoning feature type.
This Tester will be used to filter residential zones from the other zoning areas.
All single-family residential zones will start with RS, so the Tester should be set up like this:

The important thing is to set up the tests using the “Begins With” predicate.
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6) Add SpatialFilter
Add a SpatialFilter transformer to the workspace. This will be used to test each address to
show whether that address falls inside one of the filtered residential zones.
Connect the feature type AddressPoints to the SpatialFilter:Candidate port
Connect the Tester:Passed output to the SpatialFilter:Filter port.

7) Set up SpatialFilter
Open the SpatialFilter parameters dialog. Set up the parameters.
Tests to Perform should be set to CONTAINS (i.e. find addresses that the zones contain). The
Filter Type should be set to Multiple Filters (as there are multiple zoning areas). However, the
Pass Criteria parameter should be “Pass Against One Filter.”
This Pass Criteria parameter is very important. The test will fail if it is not set correctly, as a
single address cannot be in ALL zones.
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8) Add Inspectors
Now let's test what we have so far. Add Inspectors to both SpatialFilter output ports, and the
Tester:Passed port.
9) Save and Run Workspace
Save the workspace. Run the workspace. Inspect the output to prove that it has worked as
expected.
10) Add Bufferer
Now we can determine which of the filtered addresses fall within 50 metres of an arterial route.
The SpatialFilter does not have a test for "within X distance" therefore we'll have to set that up
a little differently. Add a Bufferer transformer to the workspace. Connect it to the Arterial
roads data:

Now open the parameters dialog for the Bufferer. Set the buffer amount to be 50.
Optionally you can add a Dissolver transformer after the Bufferer, to merge all the
buffer features together. The output will be the same (in terms of addresses
selected) but it will look nicer in the FME Data Inspector.
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11) Add SpatialFilter
Add a second SpatialFilter transformer. The buffered arterial routes are the Filter. The prefiltered addresses are the Candidates:

As before, open the parameters dialog and change the settings to be an overlap against
multiple filters.
12) Run Workspace
Attach some Inspector transformers to show you the output from various transformers. Save
and run the workspace. The output (zoomed in) should look like this:
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Congratulations!
You have now used filter transformers to filter data depending on different sets of
conditions.
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Data Joins

Whereas Filter transformers divide data into different
streams, other transformers bring data streams
together, merging the data according to a set of userdefined conditions.

To merge data in FME Workbench it is necessary to do more than just draw two connections
into the same input port. It is necessary to define a relationship for the basis of the join, and
this is done with one of a number of transformers.
These transformers allow you to merge not just data that is being processed by the workspace,
but provide the ability to form a join against a database or other external dataset.
Joins in FME can either be based on two matching attribute values, or they can be based on a
spatial relationship such as an overlap between features or proximity from one feature to
another.

Attribute Join Transformers
These are transformers that join data on the basis of a matching attribute value.
FeatureMerger
The FeatureMerger is the primary transformer for joining two streams of data within a
workspace. This is achieved on the basis of one or more matching attribute values (keys).
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Here, for example, a dataset of facilities has an AddressId number, but no address. The
FeatureMerger is being used to combine data from an address table into the facilities data.
Of interest for QA reasons is the NotMerged port. Here facilities that did not have a matching
AddressId are sent to a Logger transformer to record the fact that there was no match. These
records could then be checked to ensure they have a valid AddressId.
The parameters dialog for the FeatureMerger looks like this:

Notice how the AddressId attribute is being used to merge the two sets of data together. Also
notice that the merge can (and in this case does) include both attributes and geometry; i.e. the
"requestor" can be updated with the geometry of the "supplier".
Joiner
The Joiner transformer is similar to the FeatureMerger, but instead of merging two streams of
features, it merges one stream of features with data from an external database.
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Here is the same example as for the FeatureMerger above. In this case the facilities features
are obtaining address data directly from an address database. Therefore the database does not
need to be read as a stream of features in the FME workspace.
The parameters dialog for the Joiner looks like this:

Again, AddressId is being used to facilitate a merge between the two sets of data. However,
this transformer is a little more sophisticated and has parameters to control how multiple
matches are handled, as well as parameters for optimizing the database query.

Spatial Join Transformers
These are transformers that join data on the basis of a spatial relationship. There are many of
these in FME Workbench, but the following are some of the key ones.
Overlayers
There are a number of different "overlayer" transformers, each handling a different form of
overlay. For example the PointOnAreaOverlayer carries out a spatial join on points that fall
inside area (polygon) features. As the help explains, "Each point receives the attributes of the
area(s) it is contained in, and each containing area receives the attributes of each point it
contains."

Chapter 5 - Practical Transformer Use

303

FME Desktop Location Intelligence Manual

Here the facility features are being provided with a postal code depending on which postal code
polygon feature they fall inside.
The "_overlaps" attribute is another useful outcome of this transformer. It tells us how many
polygons each facility fell inside; in this case it would be an easy way to spot the problem of a
facility falling inside more than one postal code.
Conversely, the Area output would have an "_overlaps" attribute that would tell us how many
facilities fell inside each postal code.
NeighborFinder
The NeighborFinder transformer carries out a spatial join based on a proximity relationship.

Here the NeighborFinder is being used to identify the closest fire hall to each facility. The
FireHallId and FireHallAddress attributes will be merged onto each Facility feature along with a
number of useful attributes recording the X/Y coordinate, direction, and distance of the closest
fire hall.
The parameters of the NeighborFinder includes the ability to specify a maximum distance for
the relationship.
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FeatureReader
The FeatureReader is the spatial equivalent of the Joiner transformer. It reads from an
external database and forms a match based on a spatial relationship between the initiating
feature and features in the database.

Here the FeatureReader is being used to carry out the same overlay of facility and postal code,
but the postal code information is being stored in a separate database and queried to retrieve
data based on the spatial relationship with the facility.
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Data Joins
Exercise 5c Data Joins
Scenario

Mapping Crime Statistics

Data

Roads (PostGIS) Crime Statistics (CSV)

Overall Goal

Carry out a join between Crime Statistics and City Blocks

Demonstrates

Attribute-Based Data Joins

Start Workspace

None

Finish Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise5cComplete.fmw
C:\FMEData2014\Workspaces\DesktopBasic\Exercise5c-CompleteAdvanced.fmw

You have been handed a set of crime statistics in CSV (Comma Separated) format and asked to
create a map from them. In order to map the data you will need to merge it onto a set of
spatial features, such as city blocks.
1) Inspect Source Data (Crime)
The first task is to familiarize yourself with the source data. To do this open the following
dataset within the FME Data Inspector or a simple text editor.
Reader Format:
Reader Dataset:

Comma Separated Value (CSV)
C:\FMEData2014\Data\Emergency\Crime2011.csv

Parameters
File Has Field Names
Lines to Skip

Yes (Checked)
1

The data will look like this in the Data Inspector Table View window.
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Notice how there is a block number, but no other spatial information.
2) Inspect Source Data (Roads)
Now let's inspect some spatial data that we can merge the crime statistics onto. Open the
following dataset in the Data Inspector
Reader Format:
Reader Dataset:

PostGIS
fmedata

Parameters
Table List

In a web browser (Chrome, etc), go to http://fme.ly/database,
and use the Parameters for "PostGIS on Amazon RDS".
Roads

You'll see that the roads dataset has a block number that is an almost identical match to the
crime figures; the only difference is that the road block attribute is (for example) "2400"
whereas the crime data is "24XX."
The other difference is that the road data is stored in lower case ("Bute St") in the roads
dataset, whereas the crime dataset is upper case ("BUTE ST").
3) Add Readers
Now let's start working with this data. Start FME Workbench and begin with a blank canvas.
Add a Readers to the workspace using Readers > Add Reader from the menubar. This
Reader should be used to read the crime (CSV) data. Be sure to use the same parameters as
specified for the Data Inspector.
Now add a second Reader to read the roads (PostGIS) data.
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The workspace will now look like this:

4) Add StringReplacer
To merge the data we need a common block attribute. The current difference in how the block
is structured ("00" vs "XX") can be fixed very simply with a StringReplacer transformer.
Add a StringReplacer transformer and connect it to the Crime dataset feature type.

Open the parameters dialog for the StringReplacer. Set the proper parameters. The Attribute to
process will be "Block", the Text to Find will be "XX" and the Replacement Text will be "00", like
so:
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Click OK to accept the values. If you wish, attach Inspector transformers and run the
workspace to ensure the transformer is working as expected.
5) Add StringCaseChanger
The other difference in crime/road data was in UPPER/lower case street names. This can be
fixed with a StringCaseChanger transformer.
Add a StringCaseChanger transformer and connect it to the roads dataset feature type:

Open the parameters dialog. Set the parameters to change the values of HBlock to upper case:
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Why are we using the StringCaseChanger transformer here and not the
BulkAttributeRenamer (which also transforms items to upper case)? There's an
obvious difference between the two - but do you know what it is?
6) Add FeatureMerger
Now we've sorted out the structure of our join keys we can merge the data together with a
FeatureMerger.
Add a FeatureMerger to the canvas. Connect the roads data as the Requestor and the crime
data as the Supplier (we wish to supply the roads data with crime statistics):
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If, like me, you don't like connections that cross over, feel free to swap the position of the
objects around to untangle it.
Open the parameters dialog for the FeatureMerger.
The Requestor join attribute will be HBlock. The Supplier join attribute will be Block.
The comparison mode should be String and the merge type Attributes Only.
Because we can expect multiple crimes per block the parameter Process Duplicate Suppliers
should be set to Yes. To handle this we'll need to use a list so set a Supplier List Name of
CrimeList.

Click OK to close the dialog.
7) Add Inspectors
Add Inspector transformers to the Merged and NotMerged output ports (or connect both outputs
to one Inspector). This will give us the roads data with crime info attached. The NotMerged
data is important because there may be blocks without any crime.
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The Unreferenced output port will show us crimes that didn't match to a known address, so
connect a Logger transformer here to record any features that fail in this respect.

8) Save and Run Translation
Save the workspace and then run the translation. By querying a block you should be able to see
(in the Feature Information window) a list of all the crimes that occurred in that block.
We've now successfully merged crime statistics onto a set of spatial data, which is
what the aim of the example was. However, it does leave us in a fairly unsatisfactory
state, not having output or processed those figures in any way.
As an advanced task, if you have time, let's try handling the data we've just merged.
9) Add ListElementCounter
Add a ListElementCounter transformer and connect the Merged and NotMerged output ports
from the FeatureMerger. This will tell us how many crimes occurred per block. Open the
parameters dialog and select CrimeList{} as the list attribute. Enter NumberOfCrimes as the
output attribute:
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Connect an Inspector transformer and run the workspace to see what the result of this is.
10) Add MapnikRasterizer
The MapnikRasterizer is a way of creating nicely formatted map output from a set
of vector data. It is new in FME 2014
Place a MapnikRasterizer transformer after the ListElementCounter.

Open the parameters dialog. Set the output layer to be a Line symbolizer. Then click the Edit
button to the right.
For the Line Width (pixels) parameter click the drop down arrow and select Attribute Value
> Number of Crimes. Click OK to close the dialog.
Set the output raster size to be 5000 cells for both Columns and Rows.

Chapter 5 - Practical Transformer Use

313

FME Desktop Location Intelligence Manual

11) Run Workspace
Now you can add an Inspector and run the workspace.
It's a good step to turn off background maps in the Data Inspector first - else there
will be a delay while the raster output is reprojected to match.
The output will look like this:
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Basically we've created a map where road width reflects the amount of crime on that block.
The image is fairly basic at the moment, but you can enhance it by adding more layers to the
MapnikRasterizer (merge in some orthophoto data perhaps) and/or adjusting some of the other
parameters like background image.

Congratulations! You have now:
l

Pre-processed data to get join keys with a matching structure

l

Joined non-spatial data onto spatial features using a join key

l

Advanced: Created a map output of merged attribute data

Q+A Solution:
Why are we using the StringCaseChanger transformer here and not the BulkAttributeRenamer?
Because the BulkAttributeRenamer changes the case of the attribute NAMES! We want to
change the case of the attribute VALUES - and that is done with the StringCaseChanger.

Chapter 5 - Practical Transformer Use

315

FME Desktop Location Intelligence Manual

Integrated Attribute Construction

Besides direct use of attributes FME also allows you to
integrate string construction and arithmetic calculations
within transformer parameters.

Using Attributes for Parameters
Many transformer parameters allow the user to select an attribute value instead of manually
entering a fixed value. For example, the LabelPointReplacer can create a label whose contents
and height are specified by attribute values:

This is very useful because it allows the parameter (here label size) to get a different value for
each feature. One feature could create a label 10 units in height, another feature could create
one 15 units high, and so on. It is no longer a fixed value.
However, FME takes the concept a step further by integrating string and numeric editors into
parameter dialogs, so that values can be not just taken from an attribute, but can be
constructed from a mix of attributes and other user inputs.
For example, here the user is choosing to calculate label height using an arithmetic calculator:
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The calculator allows the selection and use of FME attributes, other parameters, plus a number
of mathematical and string-based functions. For example, here the user has chosen to use a
Log() function to calculate the height of their labels:

Reducing Workspace Congestion
Integrated editors and calculators provide a great benefit for workspace creation.
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Workspaces will be more compact and well-defined when as many peripheral operations as
possible are directly integrated into transformers; In other words, when a single transformer
can be used instead of a number of transformers used in series.
For example, the LabelPointReplacer can calculate label heights without the need for a prior
ExpressionEvaluator transformer.

In this way the number of transformers required to carry out a single task is reduced.

It’s important to note one particular drawback of the integrated method: you don’t
get the information as an attribute to use elsewhere. For example, you can’t create
and use a string AND also have it as an output attribute. For that you would need the
AttributeCreator as usual.
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Module Review

This module was designed to introduce you to a wider
range of FME transformers, plus a number of techniques
for applying transformers more efficiently.

What You Should Have Learned from this Module
The following are key points to be learned from this session:
Theory
l

l

l

l

l

There are distinct groups of transformers that do work other than transforming data
attributes or geometry.
A large proportion of the most-used transformers are related to attribute-handling.
Filtering is the act of dividing data. Conditional Filtering is the act of dividing data on
the basis of a test or condition.
Data Joins are carried out by transformers that merge data together, from within
Workbench or from external data sources
Integrated functionality allows the author to replace support transformers with tools
built-into operational transformers.

FME Skills
l

The ability to locate a transformer to carry out a particular task, without knowing about
that transformer in advance.

l

The ability to use common transformers for attribute management

l

The ability to use transformers for filtering and dividing data

l

The ability to use transformers for merging data together

l

The ability to build strings and calculate arithmetic values using integrated tools.

Exercise
Now let's prove what you have learned by carrying out an exercise on basic data translation
and data inspection.
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Practical Transformer Use
Exercise 5d Practical Transformer Use
Scenario

FME Workspace Author

Data

Various

Overall Goal

Identify information about a given address

Demonstrates

Advanced transformer use

Start Workspace

None

Finish Workspace

C:\FMEData2014\Workspaces\DesktopBasic\Exercise5dComplete.fmw
C:\FMEData2014\Workspaces\DesktopBasic\Exercise5d-CompleteAdvanced.fmw

In this exercise, you are a GIS technician working for a city planning department.
Today's project is for city residents. You have been asked to set up a system where they can
enter their address and find out local information; for example what neighborhood is the
address is, what public trees grow nearby, where is the nearest library, and when is the
garbage collection day.
You realize this can be done relatively easy using transformers in FME for attribute handling,
filtering, and data joins.
1) Inspect Source Data
Use the FME Data Inspector to inspect all of the datasets listed below, in order to familiarize
yourself with the data.
2) Start Workbench
Start FME Workbench and begin with an empty canvas.
Now let's first consider our strategy here. The first part of the project will be to extract the
address we want. In lieu of using a "proper" database, we'll read all of the address features
and filter out the one we want with a Tester transformer.
3) Add Reader
Add a Reader to read the following dataset:
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Reader Format:
Reader Dataset:

Esri Geodatabase (File Geodb API)
C:\FMEData2014\Data\Addresses\Addresses.gdb

Be sure to check the Workflow Options parameter. In this exercise it needs to be
"Individual Feature Types". However, if you've previously set this parameter to
"Single Merged Feature Type" it may default to that without you being aware!
When prompted the feature type to add is AddressPoints.
4) Add Tester
Add a Tester transformer to the workspace. Set it up to test for a specific address. For this
exercise we'll take the easy way and hard code that address. You can pick one from the
Data Inspector (for example, 990 BUTE).

NB: Be sure to get the Pass Criteria correct!
Connect Inspector transformers and try the workspace to make sure it works correctly. Only
one address should pass.
5) Add Readers
Now let's start to gather information about this address. To do this let's add two new Readers,
the first of which is:
Reader Format:
Reader Dataset:

Esri Geodatabase (File Geodb API)
C:\FMEData2014\Data\CommunityMapping\CommunityMap.gdb

When prompted deselect everything except GarbageSchedule from the list of feature types
(we'll use this now) and also Libraries, which we'll use later.
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Now add the second new Reader:
Reader Format:
Reader Dataset:

Google Earth KML
C:\FMEData2014\Data\Boundaries\VancouverNeighborhoods.kml

The feature type you need here is Neighborhoods. De-select everything else.
The workspace will look like this:

6) Add PointOnAreaOverlayer
Add a PointOnAreaOverlayer transformer to the workspace. Connect the Tester Passed port to
the Point input port, and the GarbageSchedule feature type to the Area.

Check the transformer parameters, but you do not need to change anything; none will have any
effect here.
7) Clean Schema
Attach an Inspector and run the workspace. You'll see that there are several attributes added
from the garbage data:
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l

Zone

l

Subzone

l

Schedule

l

NumAddresses

The only one of these we really need is Schedule. So use an AttributeRenamer to rename it
to GarbageSchedule, and use either an AttributeKeeper or AttributeRemover to delete the other
garbage attributes.
8) Add Reprojector
Now we can start to use the Neighborhood data. However, because it is in a Lat/Long
coordinate system (the address and other data is UTM83-10) we'll need to reproject it first.
Add a Reprojector transformer after the Neighborhood feature type. Open the parameters
dialog and set it to reproject from the source feature coordinate system to UTM83-10:

Now this is done you can repeat the previous two steps (PointOnAreaOverlayer/Clean Schema)
to determine which Neighborhood the address is in; the neighborhood name is the attribute we
require. If you add the PointOnAreaOverlayer before the AttributeRenamer then you can re-use
these two attribute-handling transformer for this step:
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9) Add NeighborFinder
The NeighborFinder is a tool for joining data on proximity. Add a NeighborFinder with the
address (PointOnAreaOverlayer) output connected to the Base port and the Libraries dataset
connected to the Candidate.

Open the parameters dialog. Set the Maximum Distance to be 1000 (in this case it is metres).
10) Run Workspace
Again, update the AttributeRemover to get rid of what you consider excess attributes, add an
Inspector, and run the workspace.
The Table View in the Data Inspector should show the newly merged attributes:
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In this case, the garbage schedule is Tuesday, the neighborhood West End, and the nearest
library is called Joe Fortes.
11) Add Joiner
Now to add some information about what trees exist in the area. Add a Joiner transformer to
retrieve this information from a CSV dataset. Open the Parameters dialog.
Notice that the first task is to define the dataset to read from. It is:
Reader Format:
Reader Dataset:

Comma Separated Value (CSV)
C:\FMEData2014\Data\Parks\PublicTrees.csv

Parameters
File Has Field Names
Lines to Skip

Yes (Checked)
1

In the Join parameters first select the table. There will only be a single table (either CSV or the
file name itself).
Then set the join attributes. We need to join:
l

CivicNo to StreetNumber

l

StreetName to Street

In Fields to Add select CommonName. The ability to select the attributes we want to merge
means we won't have to remove them later.
Finally, because there may be more than one tree per address, under Multiple Matches select
"Add Fields on a List Attribute" and then enter a list name (e.g. TreeList) underneath.
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Click OK to close the dialog.
12) Run Workspace
Run the workspace again. By querying the feature you should see that it now also has a list of
trees (it won't appear in the Table View, only the Feature Information window):
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We've now successfully filtered, managed, and merge some data to identify key
properties for a given address; which is what the aim of the example was. However,
it does leave us in a fairly unsatisfactory state, not having output or processed the
information in any way.
As an advanced task, if you have time, let's try handling the data we've just merged, by
creating a report in HTML.
13) Inspect HTML Template
Fortunately we already have a template for the HTML at:
C:\FMEData2014\Resources\AddressReportTemplate.html which you can open in a text editor
to familiarize yourself with. Items marked like so...
{fme:get-attribute("AttributeName")}
...will be replaced with the attribute value when we process it in FME.
14) Add XMLTemplater
Add an XMLTemplater transformer to the end of the workspace. This transformer will process
the pre-defined HTML template with the information we've just extracted.
Open the parameters dialog. Set the Root Template source to be a file and browse to the file at:
C:\FMEData2014\Resources\AddressReportTemplate.html
Set the Result Attribute to be called: text_line_data (this will match the output attribute in the
Writer below).
Set the Write XML Header parameter to be No.
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15) Add Text File Writer
Now let's add a writer to write the HTML to. We can do this is a plain text writer:
Writer Format:
Writer Dataset:

Text File
C:\FMEData2014\Output\Training\AddressReport.html

Parameters
MIME Type

text/html

Connect the new feature type to the XMLTemplater output. Run the workspace. Open the output
file in a web browser. The output should look something like this:
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Congratulations! You have now completed the exercise for this chapter.
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Chapter 6 - Course Wrap-Up
Although your FME training is now at an end, there is a
good supply of expert information available for future
assistance.

Safe Software Web Site

Our web site is the official information source for all things FME. It includes information on FME
products, Safe Software services, FME solutions, FME support and Safe Software itself.

Safe Support Team

Behind FME are passionate, fun, and knowledgeable experts, ready to help you succeed, with a
support and services philosophy built on the principle of knowledge transfer.

Safe Software Blog

The Safe Software blog (“It’s All About Data”) provides thoughts on spatial data interoperability
from the folks who make it their passion.

FME Manuals and Documentation

Use the Help function in FME Workbench to access context-sensitive help, and various manuals
and documentation for FME Desktop.
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Community Information and Resources

Safe Software actively promotes users of FME to
become part of the FME Community.

FMEpedia
FMEpedia is our community web site - a one-stop shop for all community resources, plus tools
for browsing documentation and downloads.

FME Knowledge Base
The FME Knowledge Base contains a wealth of information; including tips, tricks, examples,
and FAQs. There are sections on both FME Desktop and FME Server, with articles on topics from
installation and licensing to the most advanced translation and transformation tasks.
FME Community Answers
FME community members post FME related messages and questions and share in answering
other users’ questions. Top users are known as "heroes". Come and see how they can help with
your FME projects!

The FME Channel
This FME YouTube channel is for those demos that can only be properly appreciated through a
screencast or movie. Besides this there are a host of explanatory and helpful movies, including
recordings of most training and tutorials.

Chapter 6 - Course Wrap-Up

331

FME Desktop Location Intelligence Manual

Course Feedback

The format of this training course undergoes regular
changes prompted by comments and feedback from
previous courses.

There’s one final Q+A to go – and this time you’ll be telling us the answers!
Safe Software Inc. greatly values feedback from training course attendees. This is your chance
to tell us what you really think about how well we’re meeting your training goals.
The current course structure has been determined by attendee comments and we appreciate
your feedback more than ever.
You’ll be sent a link to a feedback form after your course.
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Certificates

All FME training course attendees receive a certificate.

Congratulations!
With the presentation of your certificate of achievement, you have now officially completed the
FME Desktop 2014 Training Course.
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Thank You

Thank you for attending this FME training course.

All of us piratical types at Safe Software Inc. wish
you good luck and fair winds with your FME voyage
of exploration.

Congratulations!

“As a reward for reading this far, here’s a small puzzle for you to try
out. Let's say it should be easy to figure out who this is!”
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Safe Software values its customers’ opinions very highly.
For questions and concerns, please use the general feedback page at: www.safe.com/contact, or
email the Training Manager directly at: training@safe.com.
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